
 

 

 

ΤΜΗΜΑ ΓΕΩΠΟΝΙΑΣ  
ΣΧΟΛΗ ΓΕΩΠΟΝΙΚΩΝ ΕΠΙΣΤΗΜΩΝ 

ΠΑΝΕΠΙΣΤΗΜΙΟ  ΠΑΤΡΩΝ 
 

ΠΤΥΧΙΑΚΗ ΕΡΓΑΣΙΑ  

«Εφαρµογή συστηµάτων γεωγραφικών πληροφοριών στην 

διαχείριση χωρικών δεδοµένων του γεωργικού τοµέα της 

Ηλείας» 

 

 

 

ΠΥΡΙΟΧΟΣ ΧΡΗΣΤΟΣ 

AM: 11909 

 

ΕΠΙΒΛΕΠΩΝ ΚΑΘΗΓΗΤΗΣ : ∆Ρ. ΝΙΚΟΛΑΟΣ 

ΜΑΛΑΜΟΣ 

 

ΑΜΑΛΙΑ∆Α 

ΙΟΥΝΙΟΣ 2019 



 

 

 

                                             

            

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

i 

 

Ευχαριστίες 

 

Θα ήθελα να ευχαριστήσω θερµά τον επιβλέποντα καθηγητή της πτυχιακής µου κ. Νικόλαο 

Μαλάµο κυρίως για την εµπιστοσύνη που µου έδειξε και την υποµονή που έκανε κατά την 

διάρκεια υλοποίησης της. Όπως επίσης και για την πολύτιµη βοήθεια και καθοδήγησή του, 

για την επίλυση διάφορων θεµάτων. 

Επιπρόσθετα θα ήθελα να ευχαριστήσω και 2 συµφοιτητές µου, τον Ντεµερούκα Ασηµάκη 

και τον Τασσόπουλο ∆ιονύσιο για την υποστήριξη που µου παρείχαν καθ΄ όλη την διάρκεια 

της πτυχιακή µελέτης. 

 

 

 

 

 

 

 

 

 

 



 

ii 

 

Πρόλογος 

 

Τα τελευταία χρόνια αναµφισβήτητα µπορούµε να πούµε ότι ζούµε στην ψηφιακή εποχή. 

Μια ψηφιακή εποχή που µας βοηθά, µας απλοποιεί και επιλύει πολλά προβλήµατα της 

καθηµερινής µας ζωής. Στην γεωργία που είναι το κοµµάτι που µας αφορά, αυτή η στήριξη 

από την τεχνολογία είναι απαραίτητη για την πρόοδο του κλάδου. Στο τοµέα όµως της 

χαρτογράφησης αυτή η ανάγκη γίνεται επιτακτική. Η ανάγκη του ανθρώπου για συστηµατική 

καταγραφή και ταξινόµηση των ιδιαίτερων στοιχείων της γήινης επιφάνειας, καθώς και η 

αναγκαιότητα διάθεσης ειδικών πληροφοριών που αφορούσαν στη γήινη επιφάνεια, ήταν οι 

αιτίες που οδήγησαν στην κατασκευή των πρώτων χαρτών, που απετέλεσαν την πρόδροµη 

µορφή των Συστηµάτων Γεωγραφικών Πληροφοριών ή αλλιώς GIS (Χαλκιάς, 2006). Μέχρι 

πριν λίγα χρόνια η χαρτογράφηση γινόταν µε χαρτί και µολύβι αξιοποιώντας στοιχεία από 

αεροφωτογραφίες, προφορικές ή ιστορικές πηγές,  µετρήσεις µε όργανα χειρός µικρής 

εµβέλειας και ακρίβειας. Τα τελευταία χρόνια η αξιοποίηση των δορυφόρων και των νέων 

τεχνολογιών υψηλής ακρίβειας ,µας δηµιουργεί µια τεράστια βάση δεδοµένων υψηλής αξίας 

και τα GIS έχουν αναδειχθεί ως µια αποτελεσµατική τεχνολογία διαχείρισης και ανάλυσης 

αυτών των γεωγραφικών δεδοµένων. Οι εξελιγµένες δυνατότητες τις οποίες παρέχουν για την 

αποθήκευση, ανάκτηση, ανάλυση, µοντελοποίηση και χαρτογραφική απόδοση εκτεταµένων 

περιοχών µε τη χρήση µεγάλου όγκου χωρικών δεδοµένων, έχει οδηγήσει σε βαθµιαία 

εξάπλωση των εφαρµογών τους. 

 

Σκοπός της εργασίας αυτής είναι να δείξουµε πως µπορούµε να δηµιουργήσουµε και να 

παράγουµε τέτοια δεδοµένα, πως να βρούµε και να εισάγουµε τα δεδοµένα αυτά σε 

κατάλληλα λογισµικά GIS αλλά και πως να αξιοποιήσουµε αυτά τα δεδοµένα µέσω αυτών 

των προγραµµάτων ώστε να φτιάξουµε ψηφιακούς - διαδραστικούς χάρτες οι οποίοι θα 

περιέχουν µεγάλο εύρος πληροφοριών σε µορφή εύκολα κατανοήσιµη και διαθέσιµη στον 

αναγνώστη. Η παρουσίαση των διαδικασιών είναι αναλυτική παρουσιάζοντας ταυτόχρονα τα 

βήµατα επεξεργασίας των χωρικών δεδοµένων τα οποία πρέπει να ακολουθήσουµε ώστε να 

φτάσουµε στο τελικό αποτέλεσµα, χρησιµοποιώντας παράλληλα πολλές εικόνες και 

διαγράµµατα. 
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Το γεωγραφικό πλαίσιο της εργασίας, περιορίστηκε στο Νοµό Ηλείας δηλαδή στο τόπο που 

βρίσκεται το Τµήµα Γεωπονίας ώστε οι πηγές, τα δεδοµένα αλλά και τα τελικά αποτελέσµατα 

να µπορούν να είναι πιο εύκολα διαχειρίσιµα και συγκρίσιµα µε άλλες πηγές. Οι µετρήσεις 

υγρασίας που αναφέρονται στο πρώτο κεφάλαιο πραγµατοποιήθηκαν σε ελαιώνα πλησίον 

του Τµήµατος Γεωπονίας στην Αµαλιάδα.  
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1 ΕΙΣΑΓΩΓΗ 

 

1.1 Γενικά 

Οι εκπληκτικές πρόοδοι που έχουν κάνει οι φυσικές επιστήµες κατά τον περασµένο αιώνα, σε 

συνδυασµό µε την αλµατώδη ανάπτυξη της τεχνολογίας οδηγούν σε γνώσεις που δίνουν 

λύσεις σε ζωτικά, άµεσα και επείγοντα προβλήµατα της καθηµερινότητας. Η χρήση των νέων 

τεχνολογιών σε όλους σχεδόν τους επιστηµονικούς και τεχνολογικούς κλάδους αναβαθµίζει 

την ποιότητα της εκάστοτε µελέτης και δίνει καινούργιες προοπτικές, αφού τα συµπεράσµατα 

απορρέουν από πληρέστερη και ακριβέστερη τεκµηρίωση. 

 

Η µεγάλη πρόοδος στην επιστήµη των υπολογιστών οδήγησε στην κατασκευή ενός 

εξαιρετικού και ισχυρού εργαλείου αποθήκευσης, διαχείρισης, ανάλυσης και παρουσίασης 

της πληροφορίας, που αποτελούν τα Συστήµατα Γεωγραφικών Πληροφοριών. Με τα 

Συστήµατα Γεωγραφικών Πληροφοριών, τα οποία εµπεριέχουν µαθηµατικές και στατιστικές 

µεθοδολογίες και στα οποία ενσωµατώνονται χαρτογραφικές τεχνικές, µπορεί να γίνει η 

διαχείριση της πληροφορίας κατά τον καλύτερο τρόπο και έτσι να καταστεί πληρέστερη και 

ακριβέστερη η εξαγωγή των συµπερασµάτων. 

1.2 Αντικείµενο της εργασίας 

Αντικείµενο της εργασίας αυτής είναι η διερεύνηση της συµβολής των συστηµάτων 

γεωγραφικών πληροφοριακών και συγκεκριµένα της εφαρµογής QGIS στην διαχείριση,  

ανάλυση και παρουσίαση, κατά τον προσφορότερο τρόπο, των δεδοµένων που εισάγουµε και 

την αποτύπωση των χωρικών πληροφοριών ώστε αυτές να µπορούν να µελετηθούν και να 

αξιολογηθούν. Η παρουσίαση γίνεται µέσω εφαρµογών, ώστε να κατανοηθούν εύκολα οι 

δυνατότητες επεξεργασίας που παρέχει το συγκεκριµένο λογισµικό. 

Στην εργασία αυτή αφού έγινε κατανοητός ο τρόπος λειτουργίας και διαχείρισης της 

γεωγραφικής πληροφορίας µέσα από λογισµικά, προσεγγίσαµε βασικές έννοιες των 

Συστηµάτων Γεωγραφικών Πληροφοριών (GIS), των µεθόδων ψηφιακής χαρτογραφίας και 

της χωρικής ανάλυσης δεδοµένων. 
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1.3 ∆ιάθρωση 

Η εργασία στο  πρώτο κεφάλαιο παρουσιάζει την γενική κατάσταση που επικρατεί στην 

Ελλάδα στο τοµέα της χαρτογράφησης και εξηγεί γιατί είναι απαραίτητη η εξέλιξη και η 

χρήση της τεχνολογίας στο τοµέα αυτό. 

Στο δεύτερο κεφάλαιο γίνεται βιβλιογραφική επισκόπηση η οποία περιλαµβάνει στοιχεία που 

είναι απαραίτητα για την κατανόηση του θέµατος. ∆ίνεται ο ορισµός και αναλύεται η 

χρησιµότητα των συστηµάτων γεωγραφικών πληροφοριών δίνοντας ιδιαίτερη έµφαση στην 

εφαρµογή ανοικτού κώδικα QGIS. 

Στο τρίτο κεφάλαιο, αναλύεται η µεθοδολογία εισαγωγής µετρήσεων εδαφικής υγρασίας από 

ένα χωράφι µε χρήση κατάλληλου αισθητήρα και οργάνου GPS, στην εφαρµογή QGIS και η 

δηµιουργία θεµατικού χάρτη µέσω της κατάλληλης επεξεργασίας των χωρικών δεδοµένων. 

Παρουσιάζονται αναλυτικά οι µεθοδολογίες ανάλυσης των διανυσµατικών δεδοµένων, η 

δηµιουργία περιµετρικών ζωνών (buffer zones), καθώς και οι µεθοδολογίες ανάλυσης 

ψηφιδωτών (raster) δεδοµένων. 

Στο τέταρτο κεφάλαιο παρουσιάζεται η διαδικασία µε την οποία µπορούµε να  

δηµιουργήσουµε χάρτες χρήσεων γης µε τις γεωργικές εκτάσεις και τον τύπο καλλιέργειας 

για συγκεκριµένη περιοχή. Για αυτή τη διαδικασία χρησιµοποιήθηκαν βασικές δυνατότητες 

του λογισµικού QGIS, όπως η επιλογή χωρικών οντοτήτων µε διάφορες εναλλακτικές 

τεχνικές αλλά και λειτουργίες όπως αυτές της ένωσης, αποκοπής, συγχώνευσης και τοµής 

οντοτήτων. 

Στο πέµπτο κεφάλαιο παρουσιάζεται η µεθοδολογία δηµιουργίας ψηφιακών µοντέλων 

εδάφους. Αφού αναφέρονται οι βασικές έννοιες, στην συνέχεια παρουσιάζονται  οι κύριες 

πηγές δεδοµένων για την κατασκευή ενός τέτοιου µοντέλου. Τέλος παρουσιάζεται µια 

εφαρµογή ανάλυσης επιφάνειας µε την οποία δηµιουργήθηκαν χάρτες µε τις υψοµετρικές 

διαφορές της περιοχής µελέτης περιοχής και της κλίσης του εδάφους. 

Το έκτο κεφάλαιο αναφέρεται στην γεωαναφορά, η οποία είναι η διαδικασία µετατροπής του 

συστήµατος αναφοράς των συντεταγµένων του µέσου ψηφιοποίησης (π.χ. ψηφιοποιητή, 

οθόνης, σαρωτή) στο σύστηµα απεικόνισης του εκάστοτε ψηφιοποιούµενου χάρτη και 

παρουσιάζεται εφαρµογή γεωαναφοράς αναλογικού χάρτη στην εφαρµογή QGIS. 
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2 ΙΣΤΟΡΙΚΗ ΑΝΑ∆ΡΟΜΗ - ΕΝΝΟΙΕΣ 
 

2.1 Συστήµατα γεωγραφικών πληροφοριών-GIS 
 

Ένα σύστηµα γεωγραφικών πληροφοριών (ΣΓΠ - GIS) είναι µία οργανωµένη συλλογή 

εξοπλισµού, λογισµικού, γεωγραφικών δεδοµένων και προσωπικού, σχεδιασµένη έτσι ώστε 

να συγκεντρώνει, αποθηκεύει, ενηµερώνει, επεξεργάζεται, αναλύει και παρουσιάζει όλους 

τους τύπους γεωγραφικών πληροφοριών. Αποτελεί εργαλείο διαχείρισης και ανάλυσης 

δεδοµένων αναφορικά µε το πού βρίσκονται και µε το τι χαρακτηριστικά έχουν, ώστε να 

είναι δυνατή η επίλυση συγκεκριµένων προβληµάτων - ερωτηµάτων που έχουν τεθεί. Τα 

συστήµατα στην Αγγλική ορολογία είναι γνωστά ως Geographic Information Systems (GIS). 

 

2.2 Η δηµιουργία και η συνεχής εξέλιξη των GIS έως σήµερα 
 

Κατά τη διάρκεια των τελευταίων πέντε δεκαετιών, τα GIS έχει εξελιχθεί από µια έννοια σε 

µια επιστήµη. Η εκπληκτική εξέλιξη των GIS από ένα στοιχειώδες εργαλείο σε µια σύγχρονη, 

ισχυρή πλατφόρµα για την κατανόηση και τον προγραµµατισµό του κόσµου µας 

χαρακτηρίζεται από πολλά βασικά ορόσηµα. 

Το πεδίο των συστηµάτων γεωγραφικών πληροφοριακών ξεκίνησε τη δεκαετία του 1960 

καθώς εµφανίστηκαν οι υπολογιστές και οι πρώιµες έννοιες της ποσοτικής και υπολογιστικής 

γεωγραφίας. Οι πρώιµες εργασίες GIS περιελάµβαναν σηµαντική έρευνα από την 

ακαδηµαϊκή κοινότητα. Αργότερα, το Εθνικό Κέντρο Γεωγραφικών Πληροφοριών και 

Ανάλυσης, µε επικεφαλής τον Michael Goodchild, επισηµοποίησε την έρευνα σε βασικά 

θέµατα γεωγραφικής πληροφορίας, όπως η χωρική ανάλυση και η απεικόνιση. Αυτές οι 

προσπάθειες τροφοδότησαν µια ποσοτική επανάσταση στον κόσµο της γεωγραφικής 

επιστήµης και έθεσαν τις βάσεις για το GIS. 

Το πρωτοποριακό έργο του Roger Tomlinson για την εκκίνηση, το σχεδιασµό και την 

ανάπτυξη του Συστήµατος Γεωγραφικών Πληροφοριών του Καναδά κατέληξε στο πρώτο 

µηχανογραφηµένο GIS στον κόσµο το 1963. Η καναδική κυβέρνηση είχε αναθέσει στον 

Tomlinson να δηµιουργήσει ένα εύχρηστο ευρετήριο των φυσικών πόρων του Καναδά, µε 

χρήση ηλεκτρονικών υπολογιστών για τη συγχώνευση των δεδοµένων από όλες τις επαρχίες. 
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Ο Tomlinson δηµιούργησε το σχέδιο για αυτοµατοποιηµένο υπολογισµό για την αποθήκευση 

και επεξεργασία µεγάλων ποσοτήτων δεδοµένων, που επέτρεψαν στον Καναδά να ξεκινήσει 

το εθνικό πρόγραµµα διαχείρισης της γης. Έδωσε επίσης στο GIS το όνοµά του. 

Το 1964 στο Northwestern University, ο Howard Fisher δηµιούργησε ένα από τα πρώτα 

προγράµµατα λογισµικού χαρτογράφησης που είναι γνωστά ως SYMAP. Το 1965 ίδρυσε το 

Εργαστήριο Γραφικών Υπολογιστών του Χάρβαρντ. Ενώ δηµιουργήθηκαν και 

εξευγενίστηκαν στο εργαστήριο ορισµένα από τα πρώτα λογισµικά κατασκευής χαρτών 

υπολογιστών, έγινε και ερευνητικό κέντρο χωρικής ανάλυσης και απεικόνισης. Πολλές από 

τις πρώτες έννοιες για το GIS και τις εφαρµογές του σχεδιάστηκαν στο εργαστήριο από µια 

ταλαντούχα συλλογή γεωγράφων, σχεδιαστών, επιστηµόνων υπολογιστών και άλλων από 

πολλούς τοµείς. 

Το 1969, ο Jack Dangermond - µέλος του Εργαστηρίου του Χάρβαρντ - και η σύζυγός του 

Laura ίδρυσαν την Environmental Systems Research Institute, Inc. (ESRI). Η εταιρεία 

συµβούλων εφάρµοσε χαρτογράφηση µέσω υπολογιστών και χωρική ανάλυση για να 

βοηθήσει τους υπεύθυνους σχεδιασµού των χρήσεων γης και τους διαχειριστές φυσικών 

πόρων να λάβουν τεκµηριωµένες αποφάσεις. Η πρόωρη εργασία της εταιρείας έδειξε την 

αξία του GIS για την επίλυση προβληµάτων. Η εταιρεία ESRI συνέχισε να αναπτύσσει 

πολλές από τις µεθόδους χαρτογράφησης και χωρικής ανάλυσης GIS που χρησιµοποιούνται 

τώρα. Αυτά τα αποτελέσµατα δηµιούργησαν ένα ευρύτερο ενδιαφέρον για τα εργαλεία 

λογισµικού και τις ροές εργασίας της εταιρείας που είναι πλέον τυποποιηµένα στο GIS. 

Καθώς οι υπολογιστές έγιναν πιο ισχυροί, η εταιρεία ESRI βελτίωσε τα εργαλεία της. Η 

εργασία σε έργα που λύνουν τα πραγµατικά προβλήµατα οδήγησε την εταιρεία στην 

καινοτοµία και την ανάπτυξη εργαλείων και προσεγγίσεων που µπορούσαν να 

χρησιµοποιηθούν ευρέως. Το έργο της εταιρείας ESRI αναγνωρίστηκε από την ακαδηµαϊκή 

κοινότητα ως ένας νέος τρόπος χωρικής ανάλυσης και προγραµµατισµού. Εξαιτίας της 

ανάγκης για αποτελεσµατικότερη ανάλυση των χωρικών δεδοµένων και λόγω του 

αυξανόµενου αριθµού έργων, η ESRI ανέπτυξε το λογισµικό ARC / INFO - το πρώτο 

εµπορικό προϊόν GIS. Η τεχνολογία κυκλοφόρησε το 1981 και άρχισε την εξέλιξη της ESRI 

σε µια εταιρεία λογισµικού. 

Σήµερα τα λογισµικά GIS δίνουν τη δυνατότητα στους χρήστες να δηµιουργούν τα δικά τους 

ψηφιακά στρώµατα χάρτη για να βοηθήσουν στην επίλυση πραγµατικών προβληµάτων. Τα 

GIS έχουν πλέον εξελιχθεί σε µέσο ανταλλαγής και συνεργασίας δεδοµένων, εµπνέοντας ένα 
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όραµα που τώρα γίνεται γρήγορα πραγµατικότητα - µια συνεχής, επικαλυπτόµενη και 

διαλειτουργική βάση των χωρικών δεδοµένων του κόσµου για σχεδόν όλα τα θέµατα. 

Σήµερα, εκατοντάδες χιλιάδες οργανισµοί µοιράζονται τη δουλειά τους και δηµιουργούν 

δισεκατοµµύρια χάρτες καθηµερινά για να πουν ιστορίες και να αποκαλύπτουν πρότυπα, 

τάσεις και σχέσεις για τα πάντα. 

 

2.3 Βασικές χρήσεις των συστηµάτων γεωγραφικών 

πληροφοριών. 

 

Οι βασικότερες χρήσεις των συστηµάτων γεωγραφικών πληροφοριών ή αλλιώς των 

λογισµικών GIS είναι η χαρτογράφηση δεδοµένων µε χωρικές πληροφορίες, η ανάλυση 

εγγύτητας, οι ζώνες ασφάλειας, η οµαδοποίηση αντικειµένων, o χωρικός εντοπισµός, η 

εύρεση στοιχείων και η ανάλυση τοποθεσίας. 

 

2.3.1 Χαρτογράφηση δεδοµένων 

Η κεντρική λειτουργία ενός συστήµατος γεωγραφικών πληροφοριών είναι η παροχή οπτικής 

αναπαράστασης δεδοµένων. Εκτιµάται ότι το 80% των δεδοµένων που επεξεργαζόµαστε έχει 

χωρικές πληροφορίες κάποιας µορφής. Το GIS αποτελεί ένα µέσο για την αποθήκευση αυτών 

των δεδοµένων σε µια βάση δεδοµένων και στη συνέχεια µε την οπτική παρουσίασή τους σε 

χαρτογραφηµένη µορφή.  

2.3.2 Ανάλυση εγγύτητας 

Η ανάλυση εγγύτητας είναι µια αναλυτική τεχνική που χρησιµοποιείται για να καθορίσει τη 

σχέση µεταξύ µιας συγκεκριµένης θέσης και άλλων τοποθεσιών ή σηµείων που συνδέονται 

µε κάποιο τρόπο. Χρησιµοποιείται από πολλούς εµπορικούς οργανισµούς για τον 

προσδιορισµό τοποθεσιών κατάλληλων για σηµεία πώλησης. Η τεχνική εξετάζει διάφορους 

παράγοντες όπως η κοινωνική και οικονοµική δηµογραφία και η παρουσία των 

ανταγωνιστών. Για µια σωστή ανάλυση εγγύτητας, οι διάφορες χωρικές πληροφορίες που θα 

χρησιµοποιηθούν πρέπει να χρησιµοποιούν το ίδιο σύστηµα αναφοράς, διαφορετικά µπορεί 

να αλλοιωθούν τα αποτελέσµατα 
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2.3.3 Ζώνες ασφάλειας 

Η συγκεκριµένη τεχνική, που διεθνώς ονοµάζεται buffering, χρησιµοποιείται συνήθως µε την 

ανάλυση εγγύτητας για να υποδείξει την επιφάνεια επιρροής ενός δεδοµένου σηµείου. Η 

προσωρινή αποθήκευση περιλαµβάνει τη δηµιουργία µιας ζώνης γύρω από ένα δεδοµένο 

σηµείο, γραµµή ή πολύγωνο (περιοχή) ορισµένης απόστασης. Η αποθήκευση buffer είναι 

χρήσιµη για τη δηµιουργία µιας ζώνης γύρω από ένα δεδοµένο γεωγραφικό χαρακτηριστικό 

για περαιτέρω ανάλυση χρησιµοποιώντας τη µέθοδο επικάλυψης. Για παράδειγµα, θα 

µπορούσε να δηµιουργηθεί ένα buffer 1000 µέτρων γύρω από ένα αγροτεµάχιο για να 

χρησιµοποιηθεί η ανάλυση επικάλυψης για να µάθουµε εάν υπάρχει καλό οδικό δίκτυο σε 

ακτίνα ενός χιλιοµέτρου από το χωράφι. 

2.3.4 Οµαδοποίηση αντικειµένων 

Οµαδοποίηση ή αλλιώς clustering ονοµάζουµε την οργάνωση µιας συλλογής από αντικείµενα 

όπως διανύσµατα ή σηµεία σε οµάδες µε βάση κάποιο µέτρο οµοιότητας. Με τη χρήση 

πολλαπλών αλγορίθµων είναι δυνατό να επιλέξουµε µια οµάδα µη σχετιζόµενων σηµείων σε 

ένα θέµα που ταιριάζει µε ένα σύνολο κριτηρίων. Ένα σύµπλεγµα θα µπορούσε να 

περιλαµβάνει µέλη όπου η απόσταση µεταξύ τους είναι µικρότερη από ένα συγκεκριµένο 

ποσό ή περιοχές όπου υπάρχει πυκνότητα βαθµών µεγαλύτερο από ένα συγκεκριµένο 

επίπεδο. Συνήθως ένα GIS θα απαιτήσει πολλαπλά επίπεδα επανάληψης πριν εντοπιστούν οι 

σωστοί αλγόριθµοι. 

2.3.5 Χωρικός εντοπισµός 

Είναι η τεχνική που µπορεί να χρησιµοποιηθεί για τη µέτρηση των αποστάσεων µεταξύ ενός 

σηµείου και της άκρης ενός συγκεκριµένου στοιχείου που έχει οριστεί ως ένα πολύγωνο 

χρησιµοποιώντας διανυσµατικά σηµεία. Ο καθορισµένος αλγόριθµος επικεντρώνεται στον 

εντοπισµό σηµείων που είναι είτε τα µέγιστα, ελάχιστα ή µεσαία µέλη του συνόλου 

δεδοµένων. 

2.3.6 Εύρεση στοιχείων για µια περιοχή 

Η εύρεση στοιχείων για µια περιοχή αποτελεί µια βασική ανάλυση που επιτρέπει σε µια 

συγκεκριµένη περιοχή να επικαλύπτεται σε δεδοµένα από άλλα θέµατα. Για παράδειγµα, το 

ερώτηµα για τον τύπο εδάφους που θα βρούµε στις γεωργικές εκµεταλλεύσεις του νοµού 

απαιτεί µια τέτοια ανάλυση. 
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2.3.7 Ανάλυση τοποθεσίας 

Η ανάλυση τοποθεσίας αποτελεί τεχνική που χρησιµοποιείται για τον εντοπισµό µιας θέσης 

για την εγκατάσταση µιας καλλιέργειας. Η τεχνική έχει αναπτυχθεί από θεωρητικές µεθόδους 

που χρησιµοποιούνται για την εξήγηση των συνθηκών που παρατηρούνται σε έναν αλγόριθµο 

για τον εντοπισµό βέλτιστων τοποθεσιών. Οι αλγόριθµοι που χρησιµοποιούνται τείνουν να 

επικεντρώνονται είτε στα µέγιστα, τα ελάχιστα είτε στα διάµεσα µέλη ενός συνόλου 

δεδοµένων. 

 

2.4 ∆υνατότητες και πλεονεκτήµατα συστηµάτων γεωγραφικών 

πληροφοριών 

 

Η χαρακτηριστική δυνατότητα που παρέχουν τα GIS είναι αυτή της σύνδεσης της χωρικής µε 

την περιγραφική πληροφορία. Γενικά τα λογισµικά GIS παρέχουν την δυνατότητα συλλογής, 

διαχείρισης, αποθήκευσης, επεξεργασίας, ανάλυσης και οπτικοποίησης, σε ψηφιακό 

περιβάλλον, των δεδοµένων που σχετίζονται µε τον χώρο. Επίσης µας δίνουν και κάποιες 

άλλες δυνατότητες όπως το να εισάγουµε την γεωγραφική πληροφορία σε ψηφιακή µορφή ή 

την αποθήκευση της σε συµπιεσµένη και ασφαλή µορφή. Επιπλέον µπορούµε να αναλύσουµε 

τα γεωγραφικά δεδοµένα µας ή να τα συνδυάσουµε για να βγάλουµε χρήσιµα συµπεράσµατα. 

Τέλος σηµαντική είναι η δυνατότητα που µας δίνει να µπορούµε να αναπαραστήσουµε τα 

δεδοµένα µας σε µορφή χαρτών ή να εξάγουµε τα συµπεράσµατά µας µε την µορφή 

στατιστικών πινάκων και διαγραµµάτων. 

Σε σχέση µε τους παραδοσιακούς µεθόδους τα λογισµικά GIS υπερτερούν σε πολλούς τοµείς. 

• Είναι γρηγορότερη και φθηνότερη η δηµιουργία των χαρτών. 

• Είναι δυνατός ο συνδυασµός διαφορετικών επιπέδων πληροφορίας. 

• Εύκολος και ακριβής εντοπισµός χωρικών στοιχείων 

• Περιορίζεται η χρήση του τυπωµένου χάρτη και πλέον µεγάλος όγκος και ποικιλία 

δεδοµένων είναι αποθηκευµένη σε ψηφιακή µορφή 

• Τα αποθηκευµένα αρχεία πλέον είναι ασφαλή από οποιοδήποτε εξωγενή παράγοντα 

όπως φυσικές καταστροφές 

• ∆ιευκολύνονται οι αναλύσεις και οι µελέτες των δεδοµένων που απαιτούν 

αλληλεπίδραση µεταξύ των στατιστικών αναλύσεων και της χαρτογράφησης. 
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• Παρέχεται η δυνατότητα δηµιουργίας χαρτών που είναι δύσκολο αν όχι αδύνατο να 

δηµιουργηθούν µε το χέρι. 

• Οποιαδήποτε στιγµή µπορούµε να επιδιορθώσουµε ή να προσθέσουµε δεδοµένα 

• Παρέχουν στοιχεία µεγάλης ακρίβειας λόγω του ψηφιακού τρόπου αποθήκευσής τους. 

• Επιτρέπουν τη συνεχή πληροφόρηση και ερµηνεία των στοιχείων σε συνδυασµό µε τη 

συνεχή ενηµέρωση, ανταλλαγή πληροφοριών και ευκολότερη διανοµή στους χρήστες. 

 

2.5 Αναπαράσταση δεδοµένων  

Τα στοιχεία του πραγµατικού κόσµου αναπαρίστανται σε διαφορετικούς επικαλυπτόµενους 

θεµατικούς χάρτες που ονοµάζονται Layers. Αυτά τα επίπεδα µπορούν να παροµοιαστούν µε 

διαφανείς σελίδες, που περιέχουν διαφορετικό είδος πληροφορίας. Τα επίπεδα πληροφορίας 

τοποθετούνται µε τέτοιο τρόπο το ένα πάνω από το άλλο, ώστε να είναι εµφανές το σύνολο 

των χαρακτηριστικών των επιµέρους επιπέδων πληροφορίας. Συνήθως, πάνω-πάνω 

τοποθετούνται τα σηµειακά επίπεδα πληροφορίας, από κάτω τα γραµµικά, πιο κάτω τα 

επιφανειακά και τέλος τα ψηφιδωτά. Η αναπαράσταση των δεδοµένων των χαρτών µπορεί να 

γίνει µε 2 τρόπους: 

� µε ψηφιδωτές µορφές (raster)  

� µε διανυσµατικές µορφές (vector) 

 

2.5.1  Ψηφιδωτές µορφές 

 

Οι ψηφιδωτές µορφές (raster) αναπαριστούν τις γεωγραφικές οντότητες ως πλέγµα ψηφίδων 

(pixels), τα οποία αποθηκεύουν µια τιµή, που µπορεί να είναι µετρήσεις, αριθµοί, ή κωδικοί. 

Ανάλογα µε το σχήµα της ψηφίδας, τα ψηφιδωτά δεδοµένα χωρίζονται σε κανονικής και µη 

κανονικής µορφής. Το µέγεθος της τετραγωνισµένης ψηφίδας, ορίζει την επιφάνεια του 

εδάφους που καλύπτει και, κατ’ επέκταση, την ανάλυση του ψηφιδωτού αρχείου. 

Σηµειώνεται ότι, όσο µικρότερο είναι το µέγεθος της ψηφίδας, τόσο υψηλότερη είναι η 

ανάλυση του αρχείου, όπως επίσης το ότι όσο αυξάνεται η λεπτοµέρεια της πληροφορίας, 

άλλο τόσο µεγαλύτερος είναι και ο αποθηκευτικός χώρος και το υπολογιστικό σύστηµα που 

απαιτείται. Τα raster δεδοµένα χρησιµοποιούνται τόσο για διακριτές οντότητες, όσο και για 

συνεχείς, όµως συνοδεύονται από πίνακα περιγραφικών χαρακτηριστικών µόνο για τα 

διακριτά δεδοµένα. Ενδείκνυται, κυρίως, για την αναπαράσταση µιας συνεχούς µεταβλητής 
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(π.χ. υψοµέτρου, βροχόπτωσης, θερµοκρασίας, εξατµισοδιαπνοής κ.λπ.). Προκειµένου να 

γίνει η σύνδεση των ψηφιδωτών δεδοµένων µε την πραγµατική τους θέση στο χώρο, 

απαιτούνται τουλάχιστον τρία ζεύγη συντεταγµένων (x, y), τα οποία συνήθως αντιστοιχούν 

στις γωνίες του raster αρχείου. Οι συνήθεις µορφές αρχείων ράστερ περιλαµβάνουν τις 

µορφές .img, .tif και κοινές µορφές εικόνας. 

2.5.2 ∆ιανυσµατικές µορφές  

 

Οι διανυσµατικές µορφές (vector) αναπαριστούν τις γεωγραφικές οντότητες ως σηµεία, 

γραµµές ή επιφάνειες (πολύγωνα) µε τις συντεταγµένες να προσδιορίζουν το σχήµα και τη 

θέση της γεωγραφικής οντότητας. Κάθε ένα από αυτά τα αντικείµενα για να εισαχθεί στο GIS 

πρέπει να καθοριστεί η φύση του (π.χ. γραµµή), στη συνέχεια η θέση του στο χώρο µέσω των 

συντεταγµένων του αρχικού (x1, y1) και τελικού σηµείου (x2, y2), τα σηµεία αλλαγής της 

διεύθυνσης της γραµµής που ονοµάζονται κόµβοι και τα σηµεία από τα οποία αποτελείται. 

Πρόκειται για συλλογές από οµοιογενή στοιχεία µε παρόµοια χαρακτηριστικά. Ενδείκνυνται 

για διακριτά δεδοµένα, όπως είναι τα διοικητικά όρια, οι δρόµοι, τα κτίρια, τα ποτάµια, οι 

λίµνες κλπ. και εκτός από τη χωρική πληροφορία που υφίσταται για αυτά, συνοδεύονται και 

από αντίστοιχη περιγραφική πληροφορία, η οποία αποθηκεύεται σε βάση δεδοµένων . 

(Ευελπίδου, 2015). Η πιο συνηθισµένη µορφή αρχείου για διανυσµατικά δεδοµένα είναι το 

shapefile. Το shapefile είναι µια συλλογή αρχείων: (.shp, .shx, .dbf). 

 

2.6 Χωρική παρεµβολή 
 

Η χωρική παρεµβολή είναι µια συχνά χρησιµοποιούµενη τεχνική για τη δηµιουργία 

συνεχόµενης επιφάνειας από διακριτά σηµεία, µετατρέποντας τα διανυσµατικά δεδοµένα σε 

ψηφιδωτά. Πολλά φαινόµενα του πραγµατικού κόσµου είναι συνεχόµενα όπως το έδαφος και 

η θερµοκρασία . Εάν θελήσουµε να µοντελοποιήσουµε αυτές τις επιφάνειες για ανάλυση, 

είναι απίθανο να πάρουµε µετρήσεις από ολόκληρη την επιφάνεια. Συνεπώς, το πεδίο των 

µετρήσεων επιλέγεται από διάσπαρτα σηµεία στην επιφάνεια και οι ενδιάµεσες τιµές 

εκτιµώνται µέσω της χωρικής παρεµβολής (Malamos & Koutsoyiannis, 2016a, b, 2018, 

Tegos et al., 2015, 2017).  
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2.7 Ψηφιακό µοντέλο εδάφους 
 

Η τεχνολογία των ψηφιακών µοντέλων εδάφους ή µε την διεθνής ονοµασία Digital Terrain 

Models (DTM), αποτελεί ένα χρήσιµο βοήθηµα στη διαδικασία ανάλυσης, επεξεργασίας και 

παρουσίασης πληροφοριών που σχετίζονται µε το φυσικό περιβάλλον .Η δηµιουργία των 

ψηφιακών µοντέλων εδάφους βασίζεται σε αρχεία καταγραφών υψοµέτρου της γήινης 

επιφάνειας και γίνεται µε δύο βασικές τεχνικές: Με την αξιοποίηση δεδοµένων 

Τηλεπισκόπησης αλλά και µε τη χρήση άµεσων καταγραφών υψοµέτρου. Για τη δηµιουργία 

ψηφιακών µοντέλων εδάφους σε µικρότερης έκτασης περιοχές αξιοποιούνται άλλες ψηφιακές 

καταγραφές οι οποίες έχουν δηµιουργηθεί µε άµεση συλλογή στοιχείων, είτε στο πεδίο, είτε 

µε φωτογραµµετρικές µεθόδους. Με αυτόν τον τρόπο και µε τεχνικές χωρικής παρεµβολής 

(spatial interpolation) είναι δυνατή η δηµιουργία ψηφιακού µοντέλου εδάφους. Oι 

δυνατότητες τις οποίες συγκεντρώνουν τα ψηφιακά µοντέλα εδάφους για την παρουσίαση, 

επεξεργασία και ανάλυση υψοµετρικών δεδοµένων τα καθιστούν απαραίτητο συστατικό ενός 

ολοκληρωµένου Συστήµατος Γεωγραφικών Πληροφοριών.  

Στις µέρες µας χρησιµοποιούνται κυρίως δύο τύποι ψηφιακών µοντέλων εδάφους: τα 

ακανόνιστα τριγωνικά δίκτυα (Triangulated Irregular Network - TIN), και τα ψηφιακά 

υψοµετρικά µοντέλα DEM (Digital Elevation Models). Η κατηγορία TIN, επειδή έχει 

ακανόνιστα πολυγωνικά αντικείµενα ως δοµικές µονάδες, έχει αντιστοιχίες µε το 

διανυσµατικό µοντέλο, ενώ η κατηγορία DEM, λόγω του ότι αποτελείται από στοιχειώδη 

οµοειδή αντικείµενα έχει αναλογίες µε το ψηφιδωτό µοντέλο.  

Η δηµιουργία ενός ψηφιακού µοντέλου εδάφους, µας δίνει τη δυνατότητα παραγωγής 

ισάριθµων γραµµών που παριστούν τη συνεχή επιφάνεια του µοντέλου. Όταν η επιφάνεια 

είναι το ανάγλυφο, προκύπτουν οι ισοϋψείς καµπύλες. Επιλέγεται η επιθυµητή ισοδιάσταση 

των καµπυλών και ο υπολογισµός γίνεται αυτόµατα µε την εφαρµογή των καταλλήλων 

αλγορίθµων. Υπάρχει, επίσης, η δυνατότητα παραγωγής χαρτών µε χρωµατική απόδοση 

υψοµετρικών ζωνών, από το ψηφιακό µοντέλο εδάφους,. Σηµειώνεται ότι, οι παράγωγες 

ισοϋψείς καµπύλες αξιοποιούνται, µεταξύ άλλων, και για τον έλεγχο της πιστότητας του 

µοντέλου συγκρινόµενες µε ισοϋψείς καµπύλες από τοπογραφικούς χάρτες. Η δυνατότητα 

δηµιουργίας παράγωγων θεµατικών επιπέδων, συχνά αποτελεί κύριο λόγο για τη δηµιουργία 

ενός ψηφιακού µοντέλου εδάφους.  

Επίσης η κλίση και ο προσανατολισµός του εδάφους µιας περιοχής είναι πληροφορίες οι 

οποίες είναι ιδιαίτερα χρήσιµες σε πληθώρα εφαρµογών. Ως κλίση (slope) µιας επιφάνειας, 
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ορίζεται ο µέγιστος ρυθµός µεταβολής του υψοµέτρου, υπολογίζεται δε, σε µοίρες ή σε 

ποσοστό επί τοις εκατό. (Χαλκιάς, 2015) 

 

2.8 Προβολές και συστήµατα συντεταγµένων 
 

Για να αναπαρασταθεί ο πραγµατικός κόσµος σε ένα GIS, θα πρέπει να µετατραπούν τα 

γεωγραφικά δεδοµένα σε ψηφιακή µορφή συµβατή µε αυτό. Ένα από τα βασικότερα 

πλεονεκτήµατα τους είναι η δυνατότητά τους να απεικονίζουν τα χωρικά δεδοµένα στη 

σωστή τους θέση στο χώρο. Για να επιτευχθεί αυτό, απαιτείται ο ορισµός του συστήµατος 

συντεταγµένων στο οποίο βρίσκονται τα εν λόγω δεδοµένα. 

2.8.1 Σύστηµα γεωγραφικών συντεταγµένων 

Το σύστηµα γεωγραφικών συντεταγµένων (geographic coordinate system) είναι το πλέον 

διαδεδοµένο σύστηµα αναφοράς. Σε αυτό προσδιορίζονται το γεωγραφικό µήκος και πλάτος , 

δηλαδή οι γωνίες από το νοητό κέντρο του ελλειψοειδούς προς ένα σηµείο στη γήινη 

επιφάνεια.. Ένας χάρτης όµως είναι συνήθως επίπεδος δηλαδή δύο διαστάσεων. Στα 

Προβολικά ή αλλιώς Καρτεσιανά συστήµατα συντεταγµένων οι θέσεις προσδιορίζονται σε 

µια επίπεδη επιφάνεια από συντεταγµένες στον άξονα των Χ (οριζόντιο) και Υ (κάθετο). Οι 

καρτεσιανές συντεταγµένες συνήθως µετριούνται σε µέτρα. Το γεωµετρικό πρόβληµα είναι η 

απεικόνιση της γης σε ένα χάρτη ή µε άλλα λόγια η απεικόνιση του ελλειψοειδούς σε ένα 

επίπεδο. 

 

2.8.2 Προβολικά συστήµατα 

Προβολικό σύστηµα ονοµάζεται ένα σύστηµα συντεταγµένων που επιτρέπει την απεικόνιση 

του ελλειψοειδούς σε ένα επίπεδο. Το σύστηµα αυτό ορίζεται από µια σειρά συναρτήσεων, 

που µεταξύ άλλων πληροφοριών, παρέχουν και το βαθµό παραµόρφωσης των σχηµάτων όταν 

απεικονίζονται στο επίπεδο. Μια προβολή µπορεί να παραµορφώνει όλες ή µερικές από τις 

ιδιότητες ενός σχήµατος του ελλειψοειδούς (διαστάσεις, µορφή και εµβαδά). Το σίγουρο 

είναι ότι τουλάχιστον ένα από τα παραπάνω µεγέθη θα παραµορφωθεί κατά την εφαρµογή 

της προβολής. 
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Υπάρχουν πολλά προβολικά συστήµατα συντεταγµένων . Ένα από τα πιο γνωστά συστήµατα 

συντεταγµένων που χρησιµοποιούνται είναι το Παγκόσµιο Γεωδαιτικό Σύστηµα Αναφοράς 

84 (World Geodetic System 1984) το οποίο χρησιµοποιείται από το δορυφορικό σύστηµα 

GPS. Στην Ελλάδα τα προβολικά συστήµατα που χρησιµοποιούνται είναι: η αζιµουθιακή 

ισαπέχουσα προβολή του ΗΑΤΤ, τα δύο συστήµατα Εγκάρσιας Μερκατορικής Προβολής 

(ΤΜ3 και UTM) και το τρίτο και πλέον πρόσφατο σύστηµα Εγκάρσιας Μερκατορικής 

Προβολής (ΕΓΣΑ 87). 

Το προβολικό σύστηµα συντεταγµένων που χρησιµοποιούµε στις εφαρµογές της παρούσας 

πτυχιακής θα είναι το ΕΓΣΑ 87 .Από την στιγµή που το κοµµάτι µελέτης αφορά µέρος της 

Ελληνικής επικράτειας τότε αυτή η επιλογή είναι πολύ χρήσιµη αφού το ΕΓΣΑ 87 είναι 

προσαρµοσµένο στην χώρα µας. Πολλές φορές µάλιστα θα χρειαστεί να το µετατρέψουµε 

από ένα άλλο προβολικό σύστηµα συντεταγµένων αφού η εφαρµογή συνήθως προεπιλέγει τα 

παγκόσµια συστήµατα όπως το WGS 84 

Το Ελληνικό Γεωδαιτικό Σύστηµα Αναφοράς (ΕΓΣΑ 87) είναι ένα γεωδαιτικό σύστηµα 

αναφοράς που χρησιµοποιείται στην Ελλάδα από το 1990. Εκλαµβάνει όλη την χώρα ως µια 

ενιαία ζώνη και χρησιµοποιεί ενιαίο συντελεστή κλίµακας. Προδιαγράφει ένα τοπικό, µη 

γεωκεντρικό datum το οποίο είναι συνδεδεµένο µε τις γεωγραφικές συντεταγµένες του 

γεωδαιτικού σταθµού του ∆ιονύσου Β∆ των Αθηνών. Το ΕΓΣΑ 87 χρησιµοποιεί το 

ελλειψοειδές GRS80, δηλαδή το ίδιο µε το γεωδαιτικό σύστηµα WGS84, αυτό που 

χρησιµοποιούν τα GPS και οι χάρτες της Google. 

 

2.9  Εφαρµογές των συστηµάτων γεωγραφικών πληροφοριών 

 

Οι εφαρµογές των GIS είναι πάρα πολλές και ουσιαστικά µπορούν να χρησιµοποιηθούν 

και να λύσουν προβλήµατα σε όλες τις δραστηριότητες που εµπλέκουν χωρικές πληροφορίες 

Μερικοί από τους τοµείς που µπορούν να βοηθήσουν είναι αυτή της επιστήµης, της διοίκησης  

επιχειρήσεων ,της βιοµηχανίας ,της δηµόσιας υγείας , της αρχιτεκτονική τοπίου ,της 

αρχαιολογίας ,των µέσων µαζικής µεταφοράς και πολλών ακόµα.  Πιο αναλυτικά θα δούµε 

κάποιες εφαρµογές των λογισµικών GIS που είναι πολύ χρήσιµες 
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� Χαρτογράφηση: Τα GIS λογισµικά αποθηκεύουν πληροφορίες σε βάσεις δεδοµένων 

και στη συνέχεια τα παρουσιάζουν µε τρόπο εποπτικό σε χαρτογραφηµένη µορφή.  

� Υπηρεσίες τηλεφωνίας/δικτύου:  Τα δεδοµένα GIS χρησιµοποιούνται για την 

ενσωµάτωση γεωγραφικών δεδοµένων στο σύνθετο σχεδιασµό δικτύων όπως το σχεδιασµό, 

τη βελτιστοποίηση, και τη συντήρηση καθώς επίσης παρέχει υπηρεσίες που σχετίζονται µε 

την τοποθεσία για την διαχείριση των πελατειακών σχέσεων. 

� Ανάλυση οδικής ασφάλειας: Το  GIS µπορεί να χρησιµοποιηθεί ως βασικό εργαλείο 

για την ελαχιστοποίηση του κινδύνου ατυχηµάτων στους δρόµους, εντοπίζοντας τις θέσεις 

των ατυχηµάτων και παρέχοντας διορθωτικά µέτρα. 

� Μεταφορές:  ∆ιαχείριση και παρακολούθηση του οδικού δικτύου ,των σιδηροδρόµων, 

και των αερογραµµών µε τη χρήση περιβαλλοντικών και τοπογραφικών δεδοµένων στην 

πλατφόρµα GIS. 

� Γεωργία: Τα  GIS µπορούν να χρησιµοποιηθούν για τη δηµιουργία 

αποτελεσµατικότερων και αποδοτικότερων γεωργικών τεχνικών, µε την ανάλυση των 

δεδοµένων του εδάφους, τον προσδιορισµό των αρδευτικών αναγκών και τη 

βελτιστοποίηση της διαχείρισης  των καλλιεργειών. 

� ∆ιαχείριση Καταστροφών: Τα GIS µπορούν να διαχειριστούν τον κίνδυνο µιας 

καταστροφής παρακολουθώντας περιοχές επιρρεπείς σε φυσικές ή ανθρωπογενείς 

καταστροφές. 

� Τοπογραφία:  Πολλοί οργανισµοί χρησιµοποιούν τώρα δορυφόρους για να κάνουν 

αυτές τις µετρήσεις και µε την βοήθεια των GIS πραγµατοποιούν τοπογραφικές έρευνες µε 

µεγάλη ακρίβεια 

� Γεωλογία: Οι  γεωλόγοι χρησιµοποιούν το GIS για να µελετήσουν γεωλογικά 

χαρακτηριστικά, να αναλύσουν τα εδάφη και τα στρώµατα, να αξιολογήσουν σεισµικές 

πληροφορίες και να δηµιουργήσουν τρισδιάστατες επιδείξεις γεωγραφικών 

χαρακτηριστικών.  

� Τουρισµός:  Οι τουρίστες µπορούν να πάρουν όλες τις πληροφορίες που χρειάζονται 

µε ένα κλικ, να µετρήσουν την απόσταση, να βρουν ξενοδοχεία, εστιατόρια και ακόµα να 

πλοηγηθούν στις αντίστοιχες συνδέσεις τους. Αυτές οι πληροφορίες διαδραµατίζουν ζωτικό 

ρόλο για τους τουρίστες στο σχεδιασµό του ταξιδιού τους από το ένα µέρος στο άλλο. 

� ∆ιαχείριση άρδευσης:  Η χρήση δορυφορικής τηλεπισκόπησης και των GIS, σε 

συνδυασµό µε τη χρήση πληροφοριών του εδάφους και των καλλιεργειών, αποτελεί πολύ 

χρήσιµη τεχνική για την αξιολόγηση των αποδόσεων της άρδευσης. 
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� ∆ασικές πυρκαγιές:  Το GIS µπορεί να συµβάλει αποτελεσµατικά στην 

παρακολούθηση των περιοχών που είναι επιρρεπείς σε πυρκαγιά σε πραγµατικό 

χρόνο. Αυτό επιτυγχάνεται µε τη βοήθεια του GNSS και της δορυφορικής τηλεπισκόπησης. 

� Φυτοϋγειονοµικός έλεγχος: Το  GIS διαδραµατίζει σηµαντικό ρόλο στη 

χαρτογράφηση των µολυσµένων περιοχών από φυτοπαθογόνους οργανισµούς. 

� Επιχειρήσεις: Το  GIS χρησιµοποιείται για τη διαχείριση των επιχειρηµατικών 

πληροφοριών µε βάση την τοποθεσία τους. Μπορεί να παρακολουθεί τον τόπο στον οποίο 

βρίσκονται οι πελάτες, τις δραστηριότητες στον ιστότοπο καθώς και τις διαφηµιστικές 

καµπάνιες που στοχεύον σε κάποια κατηγορία πελατών. 

� ∆ιαχείριση άγριας πανίδας:   Η τεχνολογία των GIS αποτελεί ένα αποτελεσµατικό 

εργαλείο για τη διαχείριση, την ανάλυση και την απεικόνιση των δεδοµένων της άγριας 

πανίδας και χλωρίδας σε περιοχές όπου απαιτούνται διεθνείς πρακτικές διαχείρισης και για 

την παρακολούθηση της αποτελεσµατικότητάς τους. Το GIS βοηθά τους επαγγελµατίες που 

διαχειρίζονται τα άγρια ζώα να εξετάσουν και να προγραµµατίσουν τις εργασίες και τα 

σχέδιά τους. 

 

2.10  Λογισµικά 

 

Υπάρχουν αρκετά συστήµατα γεωγραφικών πληροφοριών όπως: 

• Το ArcGIS 

Το ArcGIS είναι εµπορικό λογισµικό το οποίο χρησιµοποιείται ευρέως για τη δηµιουργία και 

τη χρήση χαρτών, τη σύνταξη γεωγραφικών δεδοµένων, την ανάλυση χαρτογραφηµένων 

πληροφοριών, την κοινή χρήση και την ανακάλυψη γεωγραφικών πληροφοριών, τη χρήση 

χαρτών σε µια σειρά εφαρµογών και τη διαχείριση γεωγραφικών πληροφοριών σε µια βάση 

δεδοµένων. 

 

• Το GRASS 

Το GRASS GIS (Geographic Resources Analysis Support System) είναι ένα GIS ανοικτού 

κώδικα που χρησιµοποιείται για τη διαχείριση και ανάλυση γεωχωρικών δεδοµένων, την 

επεξεργασία εικόνων, την παραγωγή χαρτών καθώς και για χωρική ανάλυση. Το GRASS 
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χρησιµοποιείται κυρίως σε ακαδηµαϊκά κέντρα σε όλο τον κόσµο, καθώς και από πολλές 

κυβερνητικές υπηρεσίες και περιβαλλοντικές συµβουλευτικές εταιρείες. 

 

• Το uDig 

 

Είναι λογισµικό που αναπτύχθηκε από την Refractions Research. Το uDig είναι βασισµένο 

στην πλατφόρµα Eclipse και είναι γραµµένο σε Java. Το uDig µπορεί να χρησιµοποιήσει 

GRASS για πολύπλοκες λειτουργίες διανυσµάτων και επίσης ενσωµατώνει το JGRASS και 

εξειδικευµένα εργαλεία υδρολογίας από τη µηχανή Horton. Υποστηρίζει τα shapefiles, το 

PostGIS, το WMS και πολλές άλλες πηγές δεδοµένων. 

 

• Το QGIS 

 

Το QGIS είναι ένα GIS ανοικτού κώδικα που θα παρουσιάσουµε αναλυτικά επειδή το 

χρησιµοποιήσαµε στην παρούσα εργασία και παρέχει ένα αξιόπιστο και φιλικό στο χρήστη 

περιβάλλον εργασίας. 

2.11  Το λογισµικό QGIS 

 

Το QGIS, το οποίο είναι επίσηµα γνωστό ως Quantum GIS (https://qgis.org/), αποτελεί µια 

εφαρµογή γεωγραφικών πληροφοριών ανοικτού κώδικα, η οποία βοηθά στην προβολή, την 

επεξεργασία και την αξιολόγηση γεωχωρικών δεδοµένων. Αυτό το λογισµικό επιτρέπει στους 

χρήστες να αξιολογήσουν και να επεξεργαστούν ειδικές πληροφορίες, εκτός από τη 

δηµιουργία και την παροχή γραφικών χαρτών. Παρέχει ένα λειτουργικό, εύχρηστο και 

ευχάριστο γραφικό περιβάλλον στο χρήστη, ενώ παράλληλα παρέχει όλες τις κοινές 

λειτουργίες και χαρακτηριστικά γνωρίσµατα αντίστοιχων συστηµάτων. Υποστηρίζει 

διάφορες ψηφιδωτές και διανυσµατικές µορφές στοιχείων, µε δυνατότητα να προσθέτονται 

εύκολα νέες δυνατότητες χρησιµοποιώντας  πρόσθετα εργαλεία. 

 

2.11.1 Λειτουργικότητα 

Το QGIS λειτουργεί ως σύστηµα γεωγραφικών πληροφοριών, επιτρέποντας στους χρήστες να 

αναλύουν και να επεξεργάζονται χωρικές πληροφορίες, παράλληλα µε τη σύνθεση και την 
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παραγωγή χαρτών. Το QGIS υποστηρίζει τόσο raster όσο και διανυσµατικά δεδοµένα. Τα 

δεδοµένα διανυσµάτων αποθηκεύονται ως χαρακτηριστικά σηµείων, γραµµών ή πολυγώνων. 

Υποστηρίζονται πολλαπλές µορφές εικόνων ράστερ και το λογισµικό µπορεί να προβάλει 

εικόνες γεωαναφοράς . 

Το QGIS υποστηρίζει shapefiles, coverages, personal geodatabases, dxf, MapInfo, PostGIS 

και άλλες µορφές αρχείων. Υποστηρίζονται επίσης υπηρεσίες Web, συµπεριλαµβανοµένης 

της υπηρεσίας Web Map Service (WMS) και της υπηρεσίας Web Feature Service (WFS), για 

να επιτρέπεται η χρήση δεδοµένων από εξωτερικές πηγές. 

Στο QGIS ενσωµατώνονται και προσθήκες (plugins) ανοιχτού κώδικα. Αυτές οι προσθήκες 

γραµµένες σε Python ή C ++ επεκτείνουν τις δυνατότητες του QGIS. Οι προσθήκες µπορούν 

να πραγµατοποιήσουν γεωκωδικοποίηση χρησιµοποιώντας το API Google Geocoding, να 

εκτελούν λειτουργίες γεωµεταποίησης παρόµοιες µε εκείνες των τυποποιηµένων εργαλείων 

που βρέθηκαν στο ArcGIS και να διασυνδέονται µε τις βάσεις δεδοµένων PostgreSQL / 

PostGIS, SpatiaLite και MySQL . 

 

2.11.2 Ανάπτυξη 

Ο Gary Sherman άρχισε να αναπτύσσει το Quantum GIS στις αρχές του 2002 και έγινε η 

πρώτη επίσηµη παρουσίασή του στο Open Source Geospatial Foundation το 2007. Η πρώτη 

έκδοση 1.0 κυκλοφόρησε τον Ιανουάριο του 2009. Από το 2017 , το QGIS είναι διαθέσιµο 

για πολλαπλά λειτουργικά συστήµατα, συµπεριλαµβανοµένων των Mac OS X , Linux , Unix 

και Microsoft Windows . Για τους χρήστες Mac, το πλεονέκτηµα του QGIS σε σχέση µε το 

GRASS GIS είναι ότι δεν απαιτεί το σύστηµα παραθύρων X11 για να τρέξει µε αποτέλεσµα η 

ψηφιακές εικόνες να είναι πολύ καθαρότερες και να γίνονται ταχύτερα .Το QGIS µπορεί 

επίσης να χρησιµοποιηθεί ως γραφική διεπαφή χρήστη µε το GRASS. Το QGIS έχει ένα 

µικρό αποτύπωµα εγκατάστασης στο σύστηµα αρχείων κεντρικού υπολογιστή σε σύγκριση 

µε τα εµπορικά GIS και απαιτεί γενικά λιγότερη µνήµη RAM και ισχύ επεξεργασίας, 

εποµένως µπορεί να χρησιµοποιηθεί σε παλαιότερο υλικό ή να τρέχει ταυτόχρονα µε άλλες 

εφαρµογές όπου η ισχύς της CPU µπορεί να είναι περιορισµένη. 

Το QGIS διατηρείται από προγραµµατιστές εθελοντών που εκδίδουν τακτικά ενηµερώσεις 

και διορθώσεις σφαλµάτων. Από το 2012, οι προγραµµατιστές έχουν µεταφράσει το QGIS σε 

48 γλώσσες και η εφαρµογή χρησιµοποιείται διεθνώς σε ακαδηµαϊκό και επαγγελµατικό 
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περιβάλλον. Πολλές εταιρείες προσφέρουν υπηρεσίες υποστήριξης και ανάπτυξης 

λειτουργιών. 

 

2.11.3 Πλεονεκτήµατα QGIS 

 

Το λογισµικό QGIS παρουσιάζει πλεονεκτήµατα σε σχέση µε τα υπόλοιπα λογισµικά 

συστηµάτων γεωγραφικών πληροφοριών. 

1. Υπάρχουν πολλές επιλογές: Το QGIS δίνει στους χρήστες ένα πλήθος διαφορετικών 

επιλογών για ειδική επεξεργασία από την αρχή και είναι δωρεάν. Υπάρχουν πολλά εργαλεία 

τα οποία  εξελίσσονται και βελτιώνονται ενώ προστίθενται συνεχώς νέα. 

2.  Μεγαλύτερη ταχύτητα και απόδοση: Το QGIS είναι πολύ γρήγορο σε σύγκριση µε 

άλλο λογισµικό όπως το ArcGIS. 

3. Το QGIS διατίθεται σε πολλές γλώσσες: Από το 2012 προγραµµατιστές έχουν 

µεταφράσει το QGIS σε 48 γλώσσες διευκολύνοντας έτσι τη λειτουργία του νέου χρήστη. 

4. Το QGIS παρουσιάζει πολύ καλή υποστήριξη:  Οι οδηγίες χρήσης, τα εγχειρίδια και 

γενικότερα οι εµπειρίες των χρηστών από την εφαρµογή είναι πάρα πολλές και δίνουν 

σηµαντική βοήθεια στους νέους χρήστες. 

5. Το QGIS δηµιουργείται από ανθρώπους που µοιράζονται την γνώση: Το QGIS έχει 

µια κοινότητα που αποτελείται κυρίως από ανθρώπους που υποστηρίζουν, γράφουν κώδικα 

και είναι πολύ παθιασµένοι για αυτό. ∆ιαθέτουν ιστολόγια και λογαριασµούς σε κοινωνικά 

δίκτυα, όπου µπορεί να ενηµερωθεί κάποιος για τα νέα εργαλεία που δηµιουργούν, ακόµα και 

να κάνει ερωτήσεις δωρεάν. 

6. Πρόσβαση και Ελευθερία: ένα από τα µεγαλύτερα πλεονεκτήµατα του QGIS είναι ότι 

έχει την ικανότητα να προσεγγίζει και την ικανότητα να προσφέρει έγκυρα εργαλεία σε όλους 

τους χρήστες. 

7. Συµβατότητα: Το QGIS είναι συµβατό µε τα Windows, το Linux, το Android και το 

Mac OS. Αυτό διευκολύνει τους χρήστες να το εγκαταστήσουν και να το χρησιµοποιήσουν 

τους προσωπικούς τους υπολογιστές. 

8. Γρήγορη µελέτη και ταχύτερη ενηµέρωση µε το QGIS: Η εξέλιξη του QGIS είναι 

πολύ γρήγορη. Κάθε φορά που υπάρχει µια νέα έκδοση του λογισµικού, υποδεικνύεται µε ένα 

αναδυόµενο παράθυρο που δίνει τη δυνατότητα λήψης, παρουσιάζοντας όλα τα νέα 

χαρακτηριστικά µαζί µε οδηγίες χρήσης. 
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9.Νοµιµότητα: Οι χρήστες QGIS έχουν καθαρή συνείδηση κατά τη χρήση του 

λογισµικού, καθώς δεν κάνουν τίποτα παράνοµο, το QGIS δεν χρησιµοποιεί λογισµικό µε 

άδεια χρήσης, είναι κατά της πειρατείας. 

10.  Ελεύθερο Λογισµικό: Το QGIS είναι ελεύθερο και δωρεάν λογισµικό σε αντίθεση µε 

τα εµπορικά λογισµικά. 
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3 ΠΡΩΤΗ ΕΦΑΡΜΟΓΗ 

3.1 Εισαγωγή  

Σκοπός της εφαρµογής αυτής είναι να δείξουµε τις βασικές λειτουργίες του QGIS 

παρουσιάζοντας µια µεθοδολογία για το πως οι µετρήσεις που παίρνουµε από ένα χωράφι µε 

οποιοδήποτε όργανο µπορούν να εισαχθούν στην εφαρµογή QGIS και µέσω κατάλληλης 

επεξεργασίας να φτιαχτεί ένας θεµατικός χάρτης. 

Αυτή η µεθοδολογία παρουσιάζεται µέσω µια εφαρµογής που αφορά την µέτρηση υγρασίας 

µε ειδικό αισθητήρα που διαθέτει το εργαστήριο Αρδεύσεων & Στραγγίσεων του Τµήµατος 

Γεωπονίας. Στην συνέχεια γίνεται εκτενής αναφορά στο τρόπο που εισάγουµε τα πρωτογενή 

δεδοµένα στην εφαρµογή, παρουσιάζονται τα βασικότερα εργαλεία επεξεργασίας όπως οι 

µεθοδολογίες ανάλυσης διανυσµατικών δεδοµένων, η δηµιουργία περιµετρικών ζωνών 

(Buffer zones), καθώς και οι µεθοδολογίες ανάλυσης ψηφιδωτών (raster) δεδοµένων. Τέλος 

µε βάση τις µετρήσεις υγρασίας που κάναµε γίνεται η παρουσίαση της τελικής εικόνας του 

πλήρους ψηφιοποιηµένου αγροτεµαχίου. 

3.2 Μετρήσεις στον Αγρό και καταγραφή στοιχείων στο excel: 

 

Με αισθητήρα µέτρησης υγρασίας ML2 - ThetaProbe της εταιρείας Delta-T, επισκεφτήκαµε 

ένα κοντινό ελαιώνα και πήραµε µετρήσεις από 30 διαφορετικά δέντρα. Σε κάθε σηµείο 

κάναµε 2 µετρήσεις ενώ εάν οι τιµές απείχαν πολύ µεταξύ τους (διαφορά πάνω από 6%) 

πραγµατοποιούσαµε και µια 3η. Παράλληλα χρησιµοποιώντας GPS καταγράφαµε τις 

συντεταγµένες του σηµείου της κάθε µέτρησης. Τις συντεταγµένες και τις µετρήσεις που 

καταγράψαµε τις περάσαµε σε υπολογιστικά φύλλα excel. 

Όπως φαίνεται στην Εικόνα 1 δηµιουργήσαµε 5 στήλες για κάθε ένα από τα στοιχεία που 

έχουµε, ενώ στην 6η στήλη βγάλαµε το µέσο όρο των 2 πρώτων µετρήσεων υγρασίας. Η 

συνάρτηση που χρησιµοποιήσαµε για το µέσο όρο ήταν η  “=AVERAGE(….)”. 
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Εικόνα 1: Φύλλο εργασίας του Excel µε µετρήσεις υγρασίας 

Επιλέγοντας τις τιµές του µέσου όρου και κάνοντας εισαγωγή στήλης δηµιουργήσαµε το 

παρακάτω ραβδόγραµµα που µας δείχνει τις τιµές των µέσων όρων των δύο µετρήσεων. 

Παρατηρώντας και συγκρίνοντας τες µεταξύ τους παρατηρήσαµε ότι οι µετρήσεις 

2,3,10,28,29 είναι µη φυσιολογικές (outliers). Οπότε επιλέξαµε να µην τις συµπεριλάβουµε 

στην παρακάτω ανάλυση. 

 

Σχήµα 1: Μέσοι όροι των µετρήσεων υγρασίας. 
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3.3 Εισαγωγή  υπολογιστικών φύλλων excel στο QGIS 

 

Για εισάγουµε το υπολογιστικό φύλλο excel στο QGIS ανοίξαµε την εφαρµογή και πατήσαµε 

διαδοχικά από την γραµµή εργαλείων: layer =>add layer =>add vector layer (Εικόνα 2) 

 

Εικόνα 2:  Αναζήτηση του «add vector layer» από την γραµµή εργαλείων. 

 

Στο επόµενο πίνακα που µας εµφάνισε επιλέξαµε file => system και πατώντας στο «Browse» 

ψάξαµε να βρούµε το αρχείο excel στο οποίο είχαµε τα αρχεία µε τις µετρήσεις, και το 

επιλέξαµε. Τέλος πατήσαµε στο κουµπί «Open». 

 

Εικόνα 3: Παράθυρο εισαγωγής διανυσµατικών δεδοµένων στην εφαρµογή 

 

Αµέσως είδαµε, ότι κάτω αριστερά  στο πίνακα Layer 

Panel µας εµφανίστηκε το αρχείο που φορτώσαµε 

(Εικόνα 4).  Αυτή η µορφή του αρχείου όµως δεν 

είναι αναγνωρίσιµη στο σύστηµά µας. 

 

 

Εικόνα 4: To αρχείο excel όπως 

εμφανίστηκε στο Layer Panel. 
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3.4 ∆ηµιουργία Vector Layer και απεικόνιση των στοιχείων στο 

χάρτη 

 

Για να γίνει το αρχείο αναγνωρίσιµο από το QGIS έπρεπε να κατεβάσουµε ένα πρόσθετο 

εργαλείο (plugin) που θα έκανε το σύστηµα να «καταλάβει» τις συντεταγµένες που 

περιλαµβάνει το αρχείο µας και προσδιορίζουν την ακριβή θέση της κάθε µέτρησης . 

Επιλέξαµε το εικονίδιο «Plugins» και στην συνέχεια στο «Manage and Install Plugins». 

(Εικόνα 5) 

 

Εικόνα 5: Επιλογή του Manage and Install Plugins από την γραµµή εργαλείων 

Στην συνέχεια στην αναζήτηση πληκτρολογήσαµε το εξής: «xyToPoint» και αφού επιλέξαµε 

το πρόσθετο που µας εµφάνισε κάναµε την εγκατάστασή του πατώντας στο «Install plugin» 

 

Εικόνα 6:  Εγκατάσταση του προσθέτου xyToPoint στην εφαρµογή 

 

Επειδή οι συντεταγµένες των σηµείων των µετρήσεων ήταν στο Ελληνικό Γεωδαιτικό 

Σύστηµα Αναφοράς 87 – ΕΓΣΑ 87 (στην Αγγλική: Greek Grid µε κωδικό 2100) έπρεπε να 

αλλάξουµε το σύστηµα αναφοράς του αρχείου του QGIS σε ΕΓΣΑ 87. Επιλέξαµε κάτω δεξιά 

στην οθόνη µας το κουτί «EPSG» και στην συνέχεια στο αναδυόµενο παράθυρο βάλαµε τικ 
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στο κουτάκι «Enable on the fly CRS transformation». Τέλος επιλέξαµε την επιλογή Greek 

Grid - EPSG:2100 και πατήσαµε «OK».(Εικόνα 7) 

 

Εικόνα 7: Αλλαγή προβολικού συστήµατος από το Project Properties/CRS 

Έπειτα βρήκαµε το εικονίδιο που µας δείχνει το πρόσθετο που µόλις εγκαταστήσαµε. 

Ονοµάζεται «xyToPoint»και βρίσκεται δεξιά στη γραµµή εργαλείων.  

Την επιλογή στο Input table δεν την 

πειράξαµε ενώ στις παρακάτω επιλογές  

επιλέξαµε την στήλη Χ για τις x 

συντεταγµένες και την στήλη Y για τις y 

συντεταγµένες. Στο «Layer name» 

διαλέξαµε ένα όνοµα για το νέο αρχείο 

που φτιάξαµε. Ιδιαίτερη προσοχή 

χρειαζόταν στην επιλογή του ονόµατος 

αφού έπρεπε να είναι στην αγγλική 

γλώσσα και να µην περιέχει κενά 

διαστήµατα µεταξύ των λέξεων. Εµείς 

ενδεικτικά αποθηκεύσαµε µε το όνοµα 

«metrisis_igrasias». Τέλος επιλέξαµε την 

επιλογή «Layer» και ήµασταν έτοιµοι να 

Εικόνα 8:Αντιστοίχιση των συντεταγµένων µε 
την πραγµατική τους θέση στο χάρτη µέσω  του 

πρόσθετου εργαλείου xyToPoint 
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πατήσουµε το κουµπί «Create Point Layer». 

 

Είδαµε, ότι µας εµφανίστηκε ένα νέο αρχείο στο Layer Panel µε το όνοµα που δώσαµε 

(Εικόνα 9) 

 

 

Το προηγούµενο αρχείο δεν µας χρειαζόταν πια, οπότε το επιλέξαµε και µε δεξί κλικ κάναµε  

«Remove». 

Σε αυτό το σηµείο έπρεπε να σώσουµε το νέο µας αρχείο, σε µορφή shapefile µέσα σε κάποιο 

φάκελο. Έτσι δεν θα ήταν κάτι το προσωρινό αλλά θα το είχαµε για πάντα και όποτε θέλαµε 

θα ανατρέχαµε στο φάκελο για να το φορτώσουµε. Για να το κάνουµε αυτό επιλέξαµε το 

αρχείο και µε δεξί κλικ πατήσαµε στο «save As». Ως Format διαλέξαµε το ESRI shapefile και 

στην συνέχεια το σώσαµε µέσα σε ένα φάκελο µε το όνοµα metrisi_igrasias. Ιδιαίτερα έπρεπε 

να προσέξουµε το CRS να ήταν σε GGR87/Greek Grid 2100 και εάν δεν ήταν να το 

επιλέξουµε. Χωρίς να πειράξουµε τίποτα άλλο , τελειώσαµε την διαδικασία πατώντας «οκ». 

(Εικόνα 10) 

  Εικόνα 9: Layer Panel 
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Εικόνα 10: Το παράθυρο µέσω του οποίου σώσαµε το αρχείο µε τα διανυσµατικά δεδοµένα 
µας 

 

Το προηγούµενο αρχείο δε µας χρειαζόταν πια, οπότε µε δεξί κλικ πάνω του και µε 

«Remove»το διαγράψαµε. Για να βλέπαµε ότι τα σηµεία των µετρήσεων  µε τις 

συντεταγµένες είχαν πάρει θέση στο σύστηµα συντεταγµένων επιλέξαµε το αρχείο και µε 

δεξί κλικ πατήσαµε στο “zoom to Layer”. Πλέον µπορούσαµε να δούµε τα σηµεία µας πως 

είναι κατανεµηµένα αλλά µας έλειπε το υπόβαθρο ή ο χάρτης του ελαιώνα πάνω στον οποίο 

αντιστοιχούν (Εικόνα 11). 
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Εικόνα 11: Τα σηµεία των µετρήσεων τοποθετηµένες στο χώρο βάση των πραγµατικών 
συντεταγµένων τους έχοντας ως σηµείο αναφοράς το ελληνικό προβολικό σύστηµα Greek 
Grid 2100. 

 

Επόµενο βήµα ήταν να προσθέσουµε ένα χάρτη ως  υπόβαθρο. Συγκεκριµένα 

χρησιµοποιήσαµε το χάρτη που µας προσφέρει η υπηρεσία της Google. Στη γραµµή 

εργαλείων, όπως βλέπουµε και στην Εικόνα 12, επιλέγαµε Web => Open Layer Plugin => 

Google Maps => Google Satellite 

 

Εικόνα 12: Εισαγωγή χάρτη της Google από την γραµµή εργαλείων 
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Ευθύς εµφανίστηκε ο χάρτης αλλά δεν βλέπαµε τα σηµεία των µετρήσεων πάνω στον 

ελαιώνα. Για να το πετύχουµε αυτό πήγαµε στο Layer Panel και πιάνοντας το αρχείο µε τα 

σηµεία µας το σύραµε πιο πάνω από το Google Satellite (Σχήµα 2) 

 

Εικόνα 13: Το Layer Panel πριν και µετά την αλλαγή 

 

Πλέον είχαµε την παρακάτω εικόνα : 

 

Εικόνα 14:Τα σηµεία των µετρήσεων απεικονίζονται στην πραγµατική τους θέση πάνω στο 
χάρτη της Google. 
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3.5 Χειρισµός σηµειακών shapefile 

 

Σε αυτήν την ενότητα θα δείξουµε πως χειριστήκαµε τα σηµειακά shapefile ώστε να 

βελτιώσουµε το οπτικό αποτέλεσµα. 

Καταρχάς θα δούµε πως αλλάξαµε χρώµα στα σηµεία των µετρήσεων. Κάναµε δεξί κλικ στο 

αρχείο µε τα σηµεία µας και επιλέξαµε «Properties => style και στο color διαλέγω το χρώµα 

που θέλαµε. Πατήσαµε οκ και βγήκαµε. Επίσης στο style µπορούσαµε να αλλάξουµε το είδος 

του συµβόλου, το µέγεθός του καθώς και άλλα χαρακτηριστικά που δεν µας ενδιέφεραν στην 

παρούσα εφαρµογή. 

 

Εικόνα 15: Αλλαγή χρώµατος και µεγέθους των σηµειακών διανυσµατικών δεδοµένων µέσω 
του πίνακα Layer Properties 

 

Επόµενη φάση είναι να δείξουµε πως κάναµε επιλογή σηµείων αλλά και πως µπορέσαµε να τα 

µετακινήσουµε. Όπως παρατηρούµε η θέση των σηµείων  είχαν απόκλιση από την πραγµατική 

τους θέση ενώ κάποια είχαν βγει και εκτός του χωραφιού. Έτσι λοιπόν προέκυψε η ανάγκη να 

σβήσουµε κάποια σηµεία και κάποια άλλα να τα µετακινήσουµε . 

Για να σβήσουµε ένα σηµείο επιλέξαµε από το Project toolbar το εικονίδιο το οποίο λεγόταν 

«select features by area or single click» και στην συνέχεια επιλέξαµε µε το ποντίκι το σηµείο 
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το οποίο θέλαµε να σβήσουµε. Μετά, στο layer panel κάναµε δεξί κλικ στο αρχείο µε τις 

µετρήσεις µας και επιλέξαµε «Open Attribute Table». Μας άνοιξε ένας µεγάλος πίνακας µε 

όλα τα περιγραφικά στοιχεία που περιέχει το αρχείο µας όπως οι συντεταγµένες των σηµείων 

και οι τιµές της υγρασίας. Παρατηρήσαµε ότι µία γραµµή ήταν ήδη επιλεγµένη. Αυτό γινόταν 

γιατί αυτή η γραµµή αντιστοιχούσε στο σηµείο που πριν επιλέξαµε. Εάν θέλαµε να διαλέξουµε 

όλα τα σηµεία, θα διαλέγαµε από την γραµµή εργαλείων την εντολή «Select all». Εάν θέλαµε 

να ξεδιαλέξουµε τα σηµεία που επιλέξαµε θα διαλέγαµε την εντολή «Deselect all» ενώ εάν 

θέλαµε να διαλέξουµε όλα τα σηµεία τα οποία δεν είναι ήδη διαλεγµένα θα επιλέγαµε την 

εντολή «Invert selection».  

Στην περίπτωσή µας το σηµείο που θέλαµε να σβήσουµε, ήταν επιλεγµένο οπότε δεν 

χρειαζόταν να κάνω µία από τις παραπάνω ενέργειες .Για να το σβήσουµε , έπρεπε πρώτα να 

ενεργοποιήσουµε την επεξεργασία του πίνακα. Για να το κάνουµε αυτό πατήσαµε στο 

εικονίδιο µε το µολυβάκι µε την εντολή «Toggle Editing mode» και στην συνέχεια στο 

εικονίδιο µε το κάδο που φέρει την εντολή «Delete selected feature». Έτσι το σηµείο µας 

σβήστηκε. Όσο είχαµε ενεργοποιηµένη την επεξεργασία µπορούσαµε προσθέσουµε ή να 

σβήσουµε κελιά, να γράψουµε µέσα σε αυτά αλλά και να προσθέσω και νέα πεδία (στήλες). 

 

Εικόνα 16: Ο πίνακας ιδιοτήτων µε όλα τα δεδοµένα που εισάγαµε. Η 3η γραµµή είναι 
επιλεγµένη γιατί αντιστοιχεί στο σηµείο που έχουµε επιλέξει για να σβήσουµε. Πάνω από το 

πίνακα φαίνεται η γραµµή εργαλείων µε τα εικονίδια που χρησιµοποιήσαµε. 
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Στην συνέχεια, θέλαµε να προσθέσουµε άλλο ένα πεδίο στην βάση δεδοµένων το οποίο θα 

περιείχε το µέσο όρο των τιµών της 1ης και της 2ης µέτρησης αλλά µε τα δικά µας κριτήρια 

όπως το να έχουν οι τιµές όσο δεκαδικά θέλαµε. Καταρχάς για να προσθέσουµε άλλο ένα πεδίο 

επιλέξαµε το εικονίδιο µε την εντολή «New field»από την γραµµή εργαλείων. Στο αναδυόµενο 

παράθυρο (Εικόνα 16) βάλαµε τα χαρακτηριστικά που θα χαρακτήριζαν το περιεχόµενό του. 

Στο όνοµα βάλαµε «aver_moist» από το average 

soil moisture δηλαδή το µέσο όρο υγρασίας 

εδάφους. Comment είναι τα σχόλια που ίσως 

θέλαµε να γράψουµε για να θυµόµασταν κάτι αλλά 

εµείς το αφήσαµε κενό. Στον τύπο κάναµε την 

επιλογή µε βάση το τι θα περιείχαν τα κελιά µας. 

Αφού τα δικά µας θα είχαν αριθµό µε δεκαδικά 

ψηφία διαλέξαµε το «Decimal number (real)». Στο 

length γράψαµε το µέγιστο µέγεθος που θέλαµε να 

έχουν οι αριθµοί µας ενώ στο Precision 

σηµειώσαµε το πλήθος των δεκαδικών. Εµείς 

διαλέξαµε 5 και 2 αντίστοιχα. Πατήσαµε «ΟΚ» και 

προχωρήσαµε. 

Μας έβγαλε µια καινούργια στήλη η οποία ήταν κενή . Εµείς έπρεπε να κάνουµε την πράξη 

(Θ1+Θ2)/2 για να µας βγάλει τις τιµές του µέσου όρου των 2 µετρήσεων υγρασίας . Για να το 

κάνουµε αυτό πήγαµε στην γραµµή εργαλείων και επιλέξαµε το εικονίδιο µε την εντολή «Field 

Calculator» η οποία µας άνοιξε ένα νέο µενού (Εικόνα 17) µέσω του οποίου µπορούσαµε να 

κάνουµε υπολογισµούς µέσα στο Attribute Table χρησιµοποιώντας διάφορες ενσωµατωµένες 

συναρτήσεις του QGIS και την κατάλληλη σύνταξη.  

 Πρώτα, τσεκάραµε το  κουτάκι «update existing field».  Από κάτω είχε ένα κρυµµένο menu 

που µας εµφάνισε τα πεδία του πίνακα. Εµείς διαλέξαµε το πεδίο που φτιάξαµε δηλαδή αυτό 

µε το όνοµα aver_moist . Πλέον έµενε να φτιάξουµε την έκφραση. Από την στήλη 

row_number επιλέξαµε το «fields and Values» και διαλέγοντας µε διπλό κλικ τα Θ1 και Θ2 

φτιάξαµε την έκφραση: ("Θ1 (%κ.ο)"   + "Θ2 (%κ.ο)" ) / 2. Πατήσαµε OK και µας έβγαλε τις 

τιµές που θέλαµε. 

Εικόνα 17: Επιλογή χαρακτηριστικών που 
θέλαµε να έχει η νέα µας στήλη. 
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Εικόνα 18: Το µενού του Field calculator µέσω του οποίου δηµιουργήσαµε ένα καινούργιο 
πεδίο συνδυάζοντας τις τιµές από δύο άλλες στήλες. 

Στη συνέχεια θα δείξουµε πως το QGIS µπορεί να βρει τις συντεταγµένες των σηµείων µε 

χρήση του Field Calculator. Στην δικιά µας εφαρµογή είχαµε τις συντεταγµένες, όµως µπορεί 

κάποιος να µας δώσει ένα shapefile που να µην 

τις είχε και εµείς να θέλουµε να τις βρούµε ώστε 

να τις εµφανίσουµε στο χάρτη. 

Για να το κάνουµε αυτό προσθέσαµε  δύο πεδία 

ακόµα µία για την συντεταγµένη x και µία για την 

συντεταγµένη y. Επιλέξαµε την εντολή «new 

field» και στο πεδίο name γράψαµε x1 ,διαλέξαµε 

το «decimal number», στο πεδίο length βάλαµε 

τον αριθµό 8 ενώ στο Precision τον αριθµό 1 

ώστε να έχουµε µόνο ένα δεκαδικό στις τιµές. 

Ακριβώς την ίδια διαδικασία κάναµε και για 

την συντεταγµένη y µε την αλλαγή ότι στο 

πεδίο name γράψαµε y1 . Στην συνέχεια και 

     Εικόνα 19: ∆ηµιουργία νέας στήλης στο 
attribute table 
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αφού δηµιουργήσαµε 2 νέες στήλες επιλέξαµε από την γραµµή εργαλείων το εικονίδιο µε την 

εντολή «field calculator» ,τικάραµε το «update existing field» όπως φαίνεται στην εικόνα 19 

και επιλέξαµε την στήλη x1 . Έπειτα διαλέξαµε από το κατάλογο row_number το «Geometry» 

και κάναµε δεξί κλικ στο «$x» ώστε να µεταφερθεί στο πίνακα αριστερά.  Για να τελειώσουµε 

την διαδικασία πατήσαµε στο OK. Ακριβώς την ίδια διαδικασία επαναλαµβάνω µε τη 

συντεταγµένη Yεπιλέγοντας το $y. 

 

Εικόνα 20:Εύρεση συντεταγµένων των επιλεγµένων σηµείων βάση της θέσης τους πάνω στο 
χάρτη µέσω από το µενού του Field calculator. 

 

Πλέον ο πίνακάς µε τα δεδοµένα διαµορφώθηκε ως εξής:

 

Εικόνα 21 : Ο πίνακας ιδιοτήτων. ∆εξιά έχουν δηµιουργηθεί 2 νέες στήλες µε τις 
συντεταγµένες των σηµείων τις οποίες αυτόµατα βρήκε η εφαρµογή µέσω των κατάλληλων 
εντολών. 
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Πάντα έπρεπε να προσέχουµε µετά από κάθε επεξεργασία να αποθηκεύουµε τις αλλαγές που 

κάναµε ώστε να µην πάνε χαµένες. Για να σώσουµε, λοιπόν τις αλλαγές αυτές επιλέξαµε από 

την γραµµή εργαλείων το εικονίδιο µε την δισκέτα που φέρει την εντολή  «Save edits», 

αποεπιλέξαµε το µολύβι ώστε να καταλάβει το σύστηµα ότι τελειώσαµε την επεξεργασία και 

κλείσαµε το attribute table. 

Όλες οι παραπάνω ενέργειες ήταν κινήσεις µέσα στο πίνακα ιδιοτήτων. Στην συνέχεια µας 

ήταν χρήσιµο να κάνουµε και κινήσεις εκτός του attribute table δηλαδή κατευθείαν πάνω στο 

χάρτη. Για παράδειγµα θα δούµε πως µπορέσαµε να µετακινήσουµε ένα σηµείο το οποίο 

βρισκόταν σε λάθος θέση πάνω στο χάρτη. 

Καταρχάς επιλέξαµε από τα εργαλεία ψηφιοποίησης την εντολή «Toggle Editing»του οποίου 

το εικονίδιο έχει ένα µολυβάκι και το οποίο όταν είναι επιλεγµένο µας επιτρέπει να κάνουµε 

διάφορες επεξεργασίες. Για να διαλέξουµε το σηµείο που θέλαµε να µετακινήσουµε ,από την 

µπάρα του project toolbar κλικάραµε στην εντολή «Select 

Feature by area or single click» και διαλέξαµε το σηµείο 

µας. Στην συνέχεια και αφού είχαµε επιλέξει ένα σηµείο 

ξαναπήγαµε στην γραµµή µε τα εργαλεία ψηφιοποίησης 

και βρήκαµε την εντολή «Move Feature» το οποίο 

συµβολίζεται µε 3 σηµεία και ένα βελάκι και µε πατηµένο 

κλικ πάνω στο σηµείο το µετακινήσαµε στην νέα του 

θέση. Τέλος αποεπιλέξαµε το εικονίδιο επεξεργασίας 

«Toggle Editing» και αποθηκεύσαµε στο «Save Layer 

Edits» που βρίσκεται επίσης στα εργαλεία ψηφιοποίησης 

(Εικόνα 21) 

 

Στην Εικόνα 21 βλέπουµε ότι υπάρχουν τρια εικονίδια µε δισκέτες. Τα δύο εικονίδια που 

βρίσκονται στην πάνω γραµµή ,δηλαδή στο Project Toolbar αποθηκεύουν ολόκληρο το project 

που κάναµε. Αντίθετα το εικονίδιο στην κάτω γραµµή µε τα εργαλεία ψηφιοποίησης 

αποθηκεύουν τις αλλαγές και τις διάφορες επεξεργασίες που κάναµε στο project και όχι 

εξολοκλήρου την εργασία.  

Επίσης µια σηµαντική λεπτοµέρεια που έπρεπε να προσέξουµε είναι ότι παρόλο που εµείς 

αλλάξαµε την θέση του σηµείου ,οι συντεταγµένες του  δεν άλλαξαν αυτόµατα. Όταν ανοίξαµε 

Εικόνα 22: Το κυκλωµένο 
εικονίδιο ανήκει στα µπάρα µε 
τα εργαλεία ψηφιοποίησης και 
φέρει την εντολή ¨Save Layer 

Edits” 
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το attribute table είδαµε ότι οι συντεταγµένες των σηµείων που µετακινήσαµε παρέµεναν ίδιες. 

Άρα εµείς έπρεπε να κάνουµε update δηλαδή να αναβαθµίσουµε τις καινούργιες 

συντεταγµένες. 

Για να γίνει αυτό πήγαµε στο ‘Field Calculator’ του attribute table και ενεργοποιήσαµε το 

«update existing field». Στην συνέχεια διαλέξαµε το πεδίο x1 και από το geometry επιλέξαµε 

το σύµβολο $x . Πατήσαµε οκ και επαναλαµβάναµε την ίδια διαδικασία και  για το y1. 

Έτσι ο πίνακας ανανεώθηκε και οι συντεταγµένες πλέον ήταν οι σωστές. Τέλος αποθηκεύσαµε 

την αλλαγή που κάναµε και επιλέξαµε το «Toggle Editing Mode» για να δηλώσουµε ότι 

τελειώσαµε την επεξεργασία και ότι βγαίνουµε  από το attribute table.  

Άλλη επεξεργασία που θα µπορούσαµε να κάνουµε είναι η προσθήκη ενός καινούργιου 

σηµείου στο χάρτη µας. Για να το κάνουµε αυτό ,ενεργοποιήσαµε την επεξεργασία πατώντας 

στο εικονίδιο µε το µολυβάκι και βρήκαµε την εντολή «Add Feature» από την µπάρα µε τα 

εργαλεία ψηφιοποίησης. Έπειτα, έχοντας ενεργοποιήσει την εντολή αυτή, επιλέξαµε ένα 

σηµείο του χάρτη στο οποίο θέλαµε να προσθέσουµε το καινούργιο σηµειακό δεδοµένο. Στο 

πίνακα που µας άνοιξε (Εικόνα 22) µας ζήτησε να δώσουµε τις πληροφορίες που είχαµε βάλει 

µέσα στο πίνακα. Εάν δεν είχαµε βάλει καµία πληροφορία θα µας τα εµφάνιζε όλες τι φόρµες  

µε την λέξη NULL δηλαδή θα ήταν κενά.  

 

Εικόνα 23: Ο αναδυόµενος πίνακας που µας εµφανίζεται όταν προσθέτουµε καινούργια 
διανυσµατικά δεδοµένα στο χάρτη.  

 

Τα πεδία στο  x και y δεν τα συµπληρώσαµε καθώς ούτε και τις τιµές της υγρασίας αφού το 

σηµείο το προσθέσαµε εµείς και δεν είχε τιµές . Το µόνο που κάναµε ήταν στο πεδίο Α/Α στο 
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οποίο βάλαµε ένα τυχαίο αριθµό µη κοντινό µε τους υπόλοιπους ώστε να καταλαβαίναµε ότι 

αυτό το σηµείο δεν προϋπήρχε αλλά προστέθηκε µια διαφορετική διαδικασία . Έτσι εµείς 

επιλέξαµε το νούµερο 100 και πατήσαµε ΟΚ. 

Στη συνέχεια από το attribute table και µέσω του «Field Calculator» κάναµε update του πεδίου 

x1 και y1 για να βρούµε τις συντεταγµένες του νέου µας σηµείου. Σώσαµε τι αλλαγές που 

κάναµε και βγήκαµε από το Attribute table αφού πρώτα είχαµε απενεργοποιήσει το «Toggle 

Editing Mode». 

 

3.6 Επεξεργασία shapefile µε πολύγωνα 

 

Μετά την επεξεργασία σηµειακών shapefile θα δούµε πως φτιάξαµε και πως χειριστήκαµε 

shapefile µε πολύγωνα. Το πρόβληµα στο οποίο έπρεπε να δώσουµε λύση ήταν η µέτρηση της 

συνολικής επιφάνειας του χωραφιού. 

Αρχικά έπρεπε να φτιάξουµε ένα shapefile δηλαδή ένα συµβατικό αρχείο, το οποίο δεν θα έχει 

πια µέσα σηµεία αλλά πολύγωνα γιατί θέλαµε να αναπαραστήσουµε την επιφάνεια της γης. 

Σκοπός ήταν µέσα σε αυτό το shapefile να ψηφιοποιούσαµε το αγροτεµάχιο χρησιµοποιώντας 

ως υπόβαθρο τη δορυφορική εικόνα της Google και στη συνέχεια να εµβαδοµετρήσουµε το 

συγκεκριµένο feature, χρησιµοποιώντας το Field Calculator, όπως κάναµε πριν µε τις 

συντεταγµένες, αλλά µε µια άλλη τώρα συνάρτηση. 

Για να δηµιουργήσουµε ένα καινούργιο Shapefile επιλέξαµε από την γραµµή εργαλείων τις 

εντολές  Layer => Create Layer => New Shapefile Layer και στο µενού που µας εµφάνισε 

(Εικόνα 23) ορίσαµε τον τύπο σε Polygon ενώ προσέξαµε το CRS να είναι σε Greek Grid-

2100.  

Στο τρίτο κοµµάτι µας ζητούσε να του πούµε τα πεδία της βάσης δεδοµένων. Ένα πεδίο θα 

ήταν η επιφάνεια, µε type: «Decimal number» ,και αναλογία συνολικών αριθµών προς 

δεκαδικά 20:2 .Πατήσαµε «add to fields list» και από το πίνακα που µας εµφάνισε το πεδίο 

area.  Προσθέσαµε επίσης το πεδίο owner (ιδιοκτήτης) µε type: «text»και 20 χαρακτήρες . 

Επίσης προσθέσαµε ένα πεδίο που σηµατοδοτούσε την τοποθεσία µε όνοµα «Location», type: 

«text data» και length: 20 χαρακτήρες 

Τέλος προσθέσαµε ένα πεδίο που θα σηµατοδοτούσε το είδος της καλλιέργειας µε όνοµα 

Cultivation πάλι µε τύπο text και µέγεθος έως 20 χαρακτήρες.  
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Εικόνα 24: ∆ηµουργία νέου αρχείου τύπου Shapefile 

 

Αφού προσθέσαµε όλα τα στοιχεία στην λίστα και πατήσαµε ΟΚ µας έβγαλε µήνυµα για το 

που θέλουµε να σώσουµε το αρχείο µας. Εµείς το αποθηκεύσαµε, σε ένα διαφορετικό φάκελο 

από εκείνον που βάλαµε τις µετρήσεις 

βάζοντας το όνοµα: Fields.  

Στο Layer Panel µας εµφανίστηκε αυτόµατα 

το νέο µας αρχείο. Κάναµε αριστερό κλικ 

πάνω σε αυτό, ενεργοποιήσαµε την 

επεξεργασία του επιλέγοντας την εντολή 

Toggle Editing και  στην συνέχεια επιλέξαµε 

το εικονίδιο που εκτελεί την εντολή «Add 

feature». 

 

 

 Εικόνα 25: Στην µπάρα µε τα εικονίδια 
ψηφιοποίησης  το εικονίδιο µε το µολυβάκι 
εκτελεί την εντολή Toggle Editing και το 

εικονίδιο µε το πολύγωνο εκτελεί την εντολή 
Add Feature 
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Επόµενο βήµα ήταν να σχεδιάσουµε την περίµετρο του χωραφιού κάνοντας διαδοχικά κλικ 

πάνω στο υπόβαθρο της Google όπως απεικονίζεται στην Εικόνα 25. Όταν είχαµε τελειώσει , 

δηλαδή όταν είχαµε φτάσει στο σηµείο που κάναµε το πρώτο κλικ πατήσαµε δεξί κλικ . 

 

Εικόνα 26: Το χωράφι µε τις γραµµές που σχηµατίσαµε περιµετρικά , έχοντας ενεργοποιήσει 
την εντολή «Toggle Editing». 

 

Όταν κάναµε δεξί κλικ, το σύστηµα, µας εµφάνισε την παρακάτω φόρµα µέσω της οποίας µας 

ζήταγε να του δώσουµε ότι στοιχεία ξέρουµε για το χωράφι ώστε να τα καταχωρήσει στα 

κατάλληλα πεδία στο Attribute table.  

 

Εικόνα 27:  Το µενού Feauture Atributes στο οποίο βάλαµε τα στοιχεία που θέλαµε να 
χαρακτηρίζουν το πολύγωνο που φτιάξαµε 
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Στο πεδίο id γράψαµε τον αριθµό 1,στο area δεν γράψαµε τίποτα γιατί δεν ξέραµε το εµβαδόν, 

στο owner βάλαµε το όνοµά µας, στο Location σηµειώσαµε την περιοχή του κτήµατος και στο 

cultivation γράψαµε το είδος της καλλιέργειας. Ολοκληρώσαµε αυτή την διαδικασία πατώντας 

στο ΟΚ. 

Πλέον στο χάρτη µας, είχε εµφανιστεί το πολύγωνο του ελαιώνα, όµως ήταν πάνω από τα 

σηµεία των µετρήσεων υπερκαλύπτοντάς τα µε αποτέλεσµα αυτά να µην φαίνονται. Για 

βάλουµε το πολύγωνο σε ένα επίπεδο πιο κάτω από τα σηµεία ώστε να φαίνονται και τα 2 

Layers πατήσαµε πάνω στο αρχείο fields που φτιάξαµε ,και  µε πατηµένο το αριστερό κλικ , το 

σύραµε πιο κάτω από το αρχείο µε τις µετρήσεις µας.  

 

Σχήµα 2: Το Layer Panel πριν και µετά την Αλλαγή 

 

Στο attribute table του πολυγώνου που φτιάξαµε υπάρχει πλέον ένα πεδίο που συµβολίζει το 

εµβαδόν του αλλά δεν υπάρχει τιµή. Για να υπολογιστεί το εµβαδόν, ανοίξαµε το Attribute 

table του αρχείο fields και ενεργοποιήσαµε την επεξεργασία «Editing mode» .Στην συνέχεια 

επιλέξαµε την εντολή «Field Calculator” και επιλέξαµε την εντολή «update existing field» που 

θα γίνει µε βάση την στήλη area.  

 

Εικόνα 28: Υπολογισµός εµβαδού του πολυγώνου µε το Field Calculator.  
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Έπειτα επιλέξαµε την λίστα συναρτήσεων «Row_number Geometry» ψάχνοντας να βρούµε τη 

συνάρτηση ‘$area’ .Μόλις την βρήκαµε µε διπλό αριστερό κλικ την προσθέσαµε στο πινακάκι 

και την διαιρέσαµε δια 1000 ώστε το αποτέλεσµα να µας βγει σε στρέµµατα. Πατήσαµε οκ και 

είδαµε ότι µας αυτόµατα το σύστηµα µας είχε συµπληρώσει το πεδίο area µε το αντίστοιχο 

εµβαδόν του ελαιώνα. Πλέον ο πίνακας µε τα δεδοµένα του πολυγώνου είχε πάρει την τελική 

του µορφή. Τέλος αποθηκεύσαµε, αποεπιλέξαµε την εντολή Toggle Editing και βγήκαµε από 

το Attribute table. 

 

Εικόνα 29: Ο πίνακας ιδιοτήτων για το πολύγωνο του ελαιώνα. Το πεδίο area συµπληρώθηκε 
αυτόµατα µε το εµβαδό του χωραφιού, υπολογισµένο σε στρέµµατα  

 

3.7 Ψηφιοποίηση της κόµης των δέντρων  

 

Στην συνέχεια θα δούµε πως ψηφιοποιήσαµε τα όρια της κόµης των ελαιόδεντρων µε απώτερο 

σκοπό να βρούµε την έκταση του ελαιώνα που δεν καλλιεργείται.  

Καταρχάς επιλέξαµε από την γραµµή εργαλείων τις εντολές Layer => Create Layer => New 

Shapefile Layer και φτιάξαµε ένα καινούργιο αρχείο. Στο ερώτηµα που µας έθεσε κατά την 

δηµιουργία σχετικά µε το τι είδους διανυσµατικά αρχεία θέλαµε να περιέχει επιλέξαµε 

πολύγωνα  ενώ στην συνέχεια δηλώσαµε ότι θέλαµε να έχει 2 πεδία (fields). Ένα µε όνοµα 

“A/A” που θα δήλωνε το κωδικό όνοµα του κάθε δέντρου, µε ιδιότητες: Whole number και 

αριθµών ψηφίων 10 και ένα άλλο πεδίο µε όνοµα «Area» που θα δήλωνε το εµβαδόν, µε 

ιδιότητες: Decimal number ,αριθµό ψηφίων 10 και αριθµό δεκαδικών 1. Πατήσαµε ΟΚ και 

σώσαµε το αρχείο µας σε ένα ξεχωριστό φάκελο µε το όνοµα «Olive_area». Πλέον στο Layer 

Panel µας εµφανίστηκε το νέο µας αρχείο. 
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Εικόνα 30: ∆ηµιουργία νέου Shapefile το οποίο θα περιείχε τα πολύγωνα που θα 
αποτυπώνουν την κόµη του κάθε δέντρου. 

 

Για να δηµιουργήσουµε τα πολύγωνα µε την κόµη των δέντρων το επιλέξαµε µε το ποντίκι και 

ενεργοποιήσαµε την επεξεργασία του πατώντας στο µολυβάκι δηλαδή στην εντολή Toggle 

Editing. Στην συνέχεια από την γραµµή µε τα εργαλεία ψηφιοποίησης διαλέξαµε την επιλογή 

«Add Circular string» και µε διαδοχικά κλικ σχεδιάζαµε κύκλους που αποτύπωναν την 

περίµετρο της κόµης των δέντρων.  

 

Σχήµα 3: Η διαδικασία βήµα βήµα για το πως κάνοντας διαδοχικά κλικ δηµιουργούσαµε 
πολύγωνα τα οποία περιέκλειναν την κόµη των δέντρων 

                                                                                                                                                       

Μόλις τελειώσαµε το σχεδιασµό ,κάναµε δεξί κλικ και στο µενού που µας εµφάνισε, στο πεδίο 

field Area γράψαµε έναν αριθµό ξεκινώντας από το 1 και φτάνοντας έως τον αριθµό που 
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αντιστοιχεί στο πλήθος των δέντρων. Τα υπόλοιπα πεδία δεν τα πειράξαµε καθόλου. Με αυτό 

τον τρόπο ψηφιοποιήσαµε την επιφάνεια που κάλυπτε η κόµη όλων των δέντρων. Όταν 

αποθηκεύσαµε και κλείσαµε την επεξεργασία, ο χάρτης µε τον ελαιώνα είχε γεµίσει µε 

πολύγωνα τα οποία συµβόλιζαν την κόµη των δέντρων. (Εικόνα 30) 

 

Εικόνα 31: Ο χάρτης µας µετά την ψηφιοποίηση της κόµης των δέντρων. 

 

Για να βρούµε το εµβαδόν του κάθε πολυγώνου πήγαµε στο Attribute table του νέου µας 

αρχείου και µέσω του Field Calculator κάναµε update στην στήλη area διαλέγοντας από το 

Geometry την εντολή $area. 

 

3.8 Χωρική παρεµβολή της εδαφικής υγρασίας του ελαιώνα. 

 

Επόµενος στόχος αυτής της εφαρµογής ήταν να µετατρέψουµε τα διανυσµατικά σηµειακά 

δεδοµένα που είχαµε από τις µετρήσεις υγρασίας σε ψηφιδωτή επιφάνεια (raster) 

χρησιµοποιώντας τη διαδικασία χωρικής παρεµβολής (spatial interpolation).  

Από την γραµµή εργαλείων επιλέξαµε τις εντολές raster => interpolation. Στο αναδυόµενο 

µενού (Εικόνα 32) εισάγαµε την έκταση και τις µετρήσεις της µέσης υγρασίας στο χωράφι. Για 

να το κάνουµε αυτό στο πεδίο Vector Layer επιλέξαµε το shapefile µε το επίπεδο που περιέχει 

τις σηµειακές µετρήσεις του ελαιώνα και στο πεδίο Interpolation attribute διαλέξαµε το 

χαρακτηριστικό του επιπέδου αυτού το οποίο µας ενδιαφέρει για την παρεµβολή, δηλαδή το 

µέσο όρο των µετρήσεων υγρασίας (Aver_moist). Επίσης έπρεπε να δηλώσουµε τον τύπο των 
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`δεδοµένων που είχαµε στο συγκεκριµένο Layer. Για τις µετρήσεις υγρασίας επιλέξαµε ως 

Type το Points αφού τα δεδοµένα είναι σηµειακής µορφής.  

 

Εικόνα 32: Στο πρόσθετο interpolation επιλέγουµε ως δεδοµένα τα σηµεία των µετρήσεων 
της εδαφικής υγρασίας στον ελαιώνα. 

Η διαδικασία Interpolation µπορεί να γίνει µε δύο µεθοδολογίες. Η πρώτη είναι µε η µέθοδος 

TIN (Triagulated Irregular Network) και η δεύτερη είναι η µέθοδος IDW (Inverse Distance 

Weighting). Η µέθοδος TIN χρησιµοποιείται συνήθως για την παραγωγή υψοµετρικά 

µοντέλων (DEM), ενώ η µέθοδος IDW χρησιµοποιείται για την παρεµβολή ποικίλων τύπων 

δεδοµένων. Εµείς προτιµήσαµε να χρησιµοποιήσουµε την µέθοδο ΙDW. Στην συνέχεια χωρίς 

να πειράξουµε τίποτα άλλο σώσαµε το νέο ψηφιδωτό αρχείο (raster) σε ένα ξεχωριστό φάκελο 

και πατήσαµε οκ.  
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Εικόνα 33:  Η επιφάνεια της εδαφικής υγρασίας του χωραφιού που έχει προκύψει από 
παρεµβολή. Οι τιµές των σηµειακών µετρήσεων χρησιµοποιήθηκαν για την εκτίµηση των 
τιµών για την περιοχή ανάµεσά τους 

 

Στην συνέχεια σώσαµε το νέο raster κάνοντας αριστερό κλικ πάνω στο αρχείο και  «save as» 

ώστε να υπάρχει µόνιµα στον υπολογιστή αλλά και για να µπορέσουµε να το επεξεργαστούµε 

στη συνέχεια. Επόµενο βήµα αποτελούσε το να περικόψουµε το raster στα όρια του 

πολυγώνου του χωραφιού. Για να κόψουµε το raster στα όρια του field επιλέξαµε διαδοχικά 

από την γραµµή εργαλείων τις εξής εντολές: Raster => Extraction => Clipper. 

Έπειτα διαλέξαµε ως εισαγόµενο αρχείο το νέο αρχείο raster και επιλέξαµε το φάκελο 

προορισµού. Στο Clipping Mode διαλέξαµε Mask Layer µε βάση το πολύγωνο fields. Τέλος 

χωρίς να πειράξουµε τα υπόλοιπα πεδία πατήσαµε ΟΚ. 
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Εικόνα 34: Το αναδυόµενο µενού της λειτουργίας Clip µέσω του οποίου κόψαµε το raster µε 
υπόβαθρο το πολύγωνο του ελαιώνα. 

 

Αυτό που είχε αποµείνει ήταν να κάνουµε κάποιες µορφοποιήσεις στο στυλ του ψηφιδωτού για 

να φανούν καλύτερα οι διαφορές στις τιµές της υγρασίας ανά δέντρο στον ελαιώνα. Με δεξί 

κλικ στο αρχείο που κάναµε clip επιλέξαµε την επιλογή properties. Στο µενού Style  επιλέξαµε 

την εντολή render type και διαλέξαµε το χρωµατισµό: «singleband pseudocolor» . 

 

Εικόνα 35: Το µενού Style µέσω του οποίου ορίσαµε πως θέλαµε να απεικονίζονταν τα 
διάφορα χαρακτηριστικά του raster. Επιλέξαµε να χωρίσουµε τις τιµές της υγρασίας σε 4 

τάξεις για τις οποίες αντιστοιχήσαµε διαφορετικά χρώµατα 
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 Στο πεδίο «Load min/ max values» διαλέξαµε το Mix/max και πατήσαµε Load. Στο πεδίο 

«mode» επιλέξαµε Quintile για να χωρίσουµε τις τιµές σε διαστήµατα και χωρίσαµε τις τάξεις 

γράφοντας σε κάθε χρώµα τους αριθµούς: 3, 6, 9 που αποτελούν τα όρια των τεσσάρων 

κλάσεων εδαφικής υγρασίας, δηλαδή η πρώτη κλάση εδαφικής υγρασίας είναι αυτή που έχει 

υγρασία µικρότερη ή ίση του 3% , η δεύτερη κλάση εδαφικής υγρασίας είναι αυτή που έχει 

υγρασία 3 – 6 %, η τρίτη κλάση εδαφικής υγρασίας είναι αυτή που έχει υγρασία που έχει 

υγρασία 6 – 9 % και η τέταρτη κλάση εδαφικής υγρασίας είναι αυτή που έχει υγρασία 

µεγαλύτερη ή ίση του 9%. Πατώντας οκ πήραµε την τελική εικόνα του ψηφιοποιηµένου χάρτη 

µας (Εικόνα 36) . 

 

Εικόνα 36: Η τελική εικόνα του ψηφιοποιηµένου χάρτη µας. Οι τιµές τις υγρασίας ήταν 
χωρισµένες σε 4 κλάσεις όπου η κάθε µία απεικονιζόταν µε διαφορετικό χρώµα σύµφωνα µε 

το Layer Panel 
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4 ∆ΕΥΤΕΡΗ ΕΦΑΡΜΟΓΗ 

 

4.1 Εισαγωγή 

 

Σκοπός αυτής της εφαρµογής ήταν να αποτυπώσουµε στο χάρτη τις γεωργικές χρήσεις γης και 

ανά περιοχή στο Νοµό Ηλείας. Τα γεωχωρικά δεδοµένα (shapefiles) που χρειαστήκαµε για την 

εφαρµογή, τα ανακτήσαµε από την ηλεκτρονική σελίδα http://geodata.gov.gr και είναι: 

• Πολύγωνα CORINE 2000, shapefile 

• nomoi_okxe, shapefile 

 

4.2 Επιλογή και Αποκοπή του Νοµού Ηλείας 

Με την εντολή «Add Vector Layer» εισάγουµε στο σύστηµα µας το shapefile των νοµών. 

Εµείς επειδή θέλαµε να αφήσουµε µόνο το νοµό Ηλείας έπρεπε να σβήσουµε όλους τους 

υπόλοιπους. Για να το κάνουµε αυτό ανοίξαµε το Attribute Τable και ενεργοποιήσαµε την 

επεξεργασία πατώντας πάνω στο εικονίδιο µε το µολυβάκι. Στην συνέχεια πήγαµε στη στήλη 

Name και επιλέξαµε ολόκληρη την γραµµή του Νοµού Ηλείας. Έπειτα επιλέξαµε «invert 

selection» ώστε να επιλεγούν όλοι οι νοµοί πλην του Νοµού Ηλείας και αφού  τους 

διαγράψαµε πατώντας στο εικονίδιο του κάδου, βγήκαµε από τον Attribute Τable. Ιδιαίτερη 

προσοχή απαιτούταν να δείξουµε στο εξής σηµείο.  ∆εν έπρεπε να κάνουµε αποθήκευση πριν 

βγούµε από το Attribute Τable γιατί τότε οι αλλαγές που κάναµε θα αποθηκευόντουσαν µέσα 

στο αρχείο που κατεβάσαµε και αφορά όλους τους νοµούς. Αυτό θα είχε σαν αποτέλεσµα να 

χάσουµε αυτό το αρχείο και να µην µπορούµε να ανατρέξουµε σε αυτό, όταν το 

ξαναχρειαστούµε. Η καλύτερη λύση σε αυτό το σηµείο ήταν να αποθηκεύσουµε το 

επεξεργασµένο αρχείο σε ένα ξεχωριστό φάκελο µε ένα όνοµα που µας έκανε να 

καταλαβαίνουµε τι περιέχει µε ευκολία. Έτσι είχαµε δύο φακέλους µε αρχεία, έναν µε όλους 

τους νοµούς και ένα µόνο µε τον Νοµό Ηλείας. 
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Εικόνα 37: Ο χάρτης µε όλους τους νοµούς. ∆εξιά είναι ανοιγµένος ο πίνακας ιδιοτήτων του 
shapefile των νοµών οποίο περιέχει πολλές χωρικές ,ποιοτικές και ποσοτικές πληροφορίες για 
το καθένα ξεχωριστά. 

 

Εναλλακτικά θα µπορούσαµε µετά την εισαγωγή του shapefile των νοµών, να το 

αποθηκεύαµε σε ένα καινούργιο φάκελο µε «save as» οπότε θα είχαµε στη διάθεση µας ένα 

αντίγραφο του αρχικού αρχείου που θα µπορούσαµε να το επεξεργαστούµε αποθηκεύοντας 

ταυτόχρονα την κάθε αλλαγή. Αυτήν την τεχνική εφαρµόσαµε σε όλες τις περιπτώσεις στις 

οποίες αλλοιώσαµε ή επεξεργαστήκαµε αρχεία.  

 

Για να αποθηκεύσουµε το αρχείο µας επιλέγουµε µε δεξί κλικ την εντολή «Save As». Στο 

πίνακα που εµφανίζεται επιλέγουµε την µορφή ESRI shapefile και αποθηκεύουµε µε το 

όνοµα «nomos_ilias». Ελέγχουµε αν το  σύστηµα συντεταγµένων είναι ΕΓΣΑ 87 (Greek 

Grid – 2100) και πατάµε ΟΚ. Στη συνέχεια, αφαιρούµε το παλιό αρχείο και κρατάµε µόνο το 

νέο το οποίο περιέχει το Νοµό Ηλείας.   

 

Αν επιθυµούµε να εστιάσουµε το χάρτη στο χωρικό επίπεδο του αρχείου µας, ώστε στην 

οθόνη µας να εµφανίζεται µόνο ο Νοµός Ηλείας, κάνουµε δεξί κλικ στο όνοµα του αρχείου 

και επιλέγουµε την εντολή «Zoom to Layer». 
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Εικόνα 38: ∆ηµιουργία καινούργιου φακέλου µε το όνοµα «nomos_illias» µέσα στο οποίο 
αποθηκεύσαµε το αρχείο µας µε τις αλλαγές που κάναµε. Το πρωτότυπο αρχείο που περιείχε 

όλους τους νοµούς βρισκόταν στο φάκελο «nomoi_okxe». 

 

4.3 Από το Corine 2000 της Ελλάδας στο Corine της Ηλείας 

 

Το επόµενο βήµα ήταν να εισάγουµε και το αρχείο που περιέχει πληροφορίες σχετικά µε τις 

χρήσεις της γης µε το όνοµα «Πολύγωνα CORINE 2000». 

Αρχικά έπρεπε να περιορίσουµε τα δεδοµένα µας µόνο για το Νοµό Ηλείας, σε δεύτερη φάση 

να κρατήσουµε µόνο την γεωργική χρήση της γης από τις υπόλοιπες χρήσεις και σε τρίτη 

φάση να κατηγοριοποιήσουµε την γεωργική χρήση µε βάση τον τύπο της καλλιέργειας. Για 

να αποκόψουµε το Corine 2000 του Νοµού Ηλείας από την υπόλοιπη Ελλάδα 

χρησιµοποιήσαµε δύο διαφορετικές µεθοδολογίες. 

 

Για την εκτέλεση της πρώτης µεθόδου επιλέξαµε από την γραµµή εργαλείων την εντολή 

«Intetify Features» και κάναµε αριστερό κλικ σε ένα σηµείο που ανήκει στο Νοµό Ηλείας. 

Στο πίνακα που άνοιξε εµφανίζονται πληροφορίες από το attribute table του shapefile Corine 

2000 για την περιοχή που επιλέξαµε. Η πληροφορία που µας ενδιέφερε ήταν η γραµµή 
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NOMOS και ο κωδικός 14 στον οποίο αντιστοιχεί. Αυτό σήµαινε πως όλες οι χωρικές 

υποδιαιρέσεις του νοµού Ηλείας συµβολίζονταν µε το νούµερο 14. 

 

 

Εικόνα 39:  Το κυκλωµένο εικονίδιο στην γραµµή εργαλείων εκτελεί την εντολή  «Identify 
Features». Στο πίνακα που µας ανοίγει βλέπουµε στο υπογραµµισµένο πεδίο µε του νοµούς 
ότι ο Nοµός Ηλείας αντιστοιχεί στον κωδικό 14. Έτσι ξέραµε ότι όλα τα υπόλοιπα κοµµάτια 
του νοµού θα είχαν τον ίδιο αριθµό.   

Στην συνέχεια πήγαµε στο Attribute Table του αρχείου και από την στήλη NOMOS επιλέξαµε 

τις γραµµές που έφεραν το νούµερο 14. Εκτός από χειροκίνητα ένας άλλος πιο σύντοµος 

τρόπος που χρησιµοποιήσαµε για να το κάνουµε ήταν από την γραµµή εντολών. Εκεί 

επιλέξαµε την εντολή «Filter» και έπειτα στην γραµµή NOMOS πληκτρολογήσαµε το νούµερο 

14. Πατήσαµε «Select Features» και επιλέξαµε όλα τα δεδοµένα που αφορούσαν το Νοµό 

Ηλείας. Για γυρίσουµε στην αρχική µορφή του πίνακα επιλέξαµε κάτω δεξιά το εικονίδιο 

«Switch to table view». 
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Εικόνα 40: Το µενού της εντολής «Filter». Στο κενό πεδίο NOMOS Συµπληρώσαµε τον 
αριθµό 14 που αντιστοιχεί στο νοµό Ηλείας. Κάτω δεξιά είναι η επιλογή «Select features» 

ενώ το κυκλωµένο εικονίδιο εκτελεί την εντολή  « Switch to table view» 

 

 

Με την ίδια µεθοδολογία που ακολουθήσαµε και προηγουµένως, δηλαδή χρησιµοποιώντας 

τις εντολές «Invert Selection» και «Delete» σβήσαµε όλα τα υπόλοιπα δεδοµένα και 

αποθηκεύσαµε το αρχείο σε ένα νέο φάκελο µε το όνοµα «corine_ilia». 

Η δεύτερη µεθοδολογία που χρησιµοποιήσαµε για την ίδια διαδικασία ήταν πιο απλή και πιο 

γρήγορη αφού δεν θα εµπλακήκαµε  καθόλου µε του πίνακες των αρχείων. Από την γραµµή 

εργαλείων θα πήγαµε Vector => GeoprocessingTools => Clip 



 

51 

 

 

Εικόνα 41: Επιλέγοντας από την γραµµή εργαλείων Vector και Geoprocessing Tools 
βρήκαµε την εντολή Clip µε την οποία περικόψαµε το νοµό Ηλείας από όλη την υπόλοιπη 
Ελλάδα. 

 

Στο µενού του Clip επιλέξαµε στο input layer το shapefile του Corine 2000 της Ελλάδας και 

στο clip layer το Νοµό Ηλείας. Αποθηκεύσαµε το αρχείο σε νέο φάκελο µε όνοµα Corine_ilia 

και πατήσαµε Run.  Και µε τις δύο µεθοδολογίες το αποτέλεσµα ήταν το ίδιο. 

 

Εικόνα 42: Ο καµβάς µας όπως είχε διαµορφωθεί µε την αποµόνωση του Νοµού Ηλείας από 
την Υπόλοιπη Ελλάδα. 
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4.4 Επιλογή των γεωργικών εκτάσεων του Νοµού Ηλείας από τη 

βάση δεδοµένων Corine 2000 

 

Σε αυτό το σηµείο έπρεπε να διαφοροποιήσουµε τις χρήσεις γης σε αγροτικές και µη 

αγροτικές και να κρατήσουµε µόνο αυτές που µας αφορούσαν. Από τον ιστότοπο 

http://uls.eionet.europa.eu/CLC2000/classes ανακτήσαµε έναν πίνακα που αναφέρει ότι 

κωδικοί της βάσης δεδοµένων από 2.1.1 έως 2.4.4 συµβολίζουν τις περιοχές µε αγροτικές 

καλλιέργειες.  

 

 

Εικόνα 43: Ο πίνακας που βρήκαµε στον ιστότοπο της ΙΟΝΕΤ και µας εξηγούσε τι 
συµβόλιζε ο κάθε κωδικός που περιεχόταν στο Atribute Table του Corine. Οι κωδικοί που 
αφορούσαν τις αγροτικές εκµεταλλεύσεις της γης ήταν από τον κωδικό 2.1.1 έως τον 2.4.4. 

 

Ανοίγοντας το Attribute table του αρχείου βρήκαµε την στήλη «DXF_TEXT»και επιλέξαµε 

τα δεδοµένα µε τους ανωτέρω κωδικούς. Έπειτα µε την διαδικασία του invert «selection» και 

«Delete» διαγράψαµε τις υπόλοιπες και σώσαµε το νέο µας αρχείο σε ένα νέο φάκελο µε 

όνοµα «Corine_ilia_agrotica» 
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Στο τελικό στάδιο στο οποίο θέλαµε να αποτυπώσουµε τους τύπους καλλιέργειας στο νοµό 

Ηλείας έπρεπε να κατηγοριοποιήσουµε τον κάθε κωδικό µε βάση αυτό που απεικονίζει και να 

απεικονισθεί µε διαφορετικό χρώµα. Από το : 

http://portal.survey.ntua.gr/main/labs/rsens/rs/corine_nomenclature_el.pdf ανακτήσαµε τον 

παρακάτω πίνακα που περιέχει την ερµηνεία του κάθε κωδικού. 

Πίνακας 1: Ο πίνακας µε την Ελληνική ονοµατολογία CORINE LAND COVER 

 

 

Με δεξί κλικ στο αρχείο µας, επιλέξαµε στο µενού «Properties» το µενού «Style». 

 

Εικόνα 44: Από το µενού Style, ορίσαµε βάση ποιου χαρακτηριστικού θα γίνει η 
κατηγοριοποίηση. Στην συνέχεια στο κάθε κωδικό δώσαµε ένα ξεχωριστό χρώµα αλλά και 
όνοµα.  
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Στο σηµείο που µας ζητάει τον τρόπο συµβολισµού των στοιχείων του Layer επιλέξαµε 

«Categorized» µε βάση την στήλη DXF_TEXT. Στην συνέχεια επιλέξαµε την εντολή 

«Classify» ώστε ο πίνακας να γεµίσει µε τους κωδικούς που είχαν µείνει στην στήλη αυτή. 

Στην συνέχεια πήγαµε µέσα στον πίνακα και στην στήλη «Legend», στην θέση του κάθε 

κωδικού γράψαµε το τι συµβόλιζε ο καθένας. Το τελικό αποτέλεσµα φαίνεται στην 

Εικόνα 46. 

 

Εικόνα 45: Ο χάρτης µε τον νοµό Ηλείας. Με διάφορα χρώµατα φαίνονται οι κατηγορίες 
στις οποίες χωρίστηκε ο νοµός βάση της αγροτικής χρήσης της γης 
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5 ΤΡΙΤΗ ΕΦΑΡΜΟΓΗ 
 

5.1 Εισαγωγή 
 

Σκοπός της τρίτης εφαρµογής ήταν η δηµιουργία του ψηφιακού υψοµετρικού µοντέλου - 

DEM (Digital Elevation Model) που θα αφορούσε την περιοχή της Ηλείας καθώς και η 

κατηγοριοποίηση της κλίσης του εδάφους σύµφωνα µε την ΚΥΑ 168040/2010 (ΦΕΚ 1528 

Β’), δηλαδή: 

• Πρώτη κατηγορία κλίσης: 0% έως 8%,  

• ∆εύτερη κατηγορία κλίσης: 8% έως 25%  

• Τρίτη κατηγορία κλίσης: πάνω από 25%.  

 

5.2 Εισαγωγή ισοϋψών καµπύλων  και επεξεργασία τους 

Οι ισοϋψείς καµπύλες του Νοµού Ηλείας αναζητήθηκαν στον ιστότοπο: www.opendem.info 

ο οποίος διαθέτει πληροφορίες για το υψόµετρο όλης της υδρογείου. Επιλέξαµε την καρτέλα 

Downloads και µετά το: «SRTM Contours as SHP». Έπειτα πατήσαµε τυχαία πάνω στο 

χάρτη που άνοιξε και στην συνέχεια µε την βοήθεια του εργαλείου «Control» εστιάσαµε στην 

περιοχή που µας ενδιέφερε. Τέλος µε πατηµένο το κουµπί «Shift» σχεδιάσαµε ένα πλαίσιο 

που περιείχε το νοµό Ηλείας. Στο παράθυρο που µας άνοιξε επιλέξαµε το αρχείο zip µε το 

τίτλο «Ν37Ε021» και το αποθηκεύσαµε σε ένα φάκελο του υπολογιστή µας µε το όνοµα 

«ipsometriko_ilιas». Με την εντολή «Add vector Layer» εισάγουµε το αρχείο στο πρόγραµµα 

ενώ παράλληλα προσθέσαµε και το shapefile µε το Νοµό Ηλείας  

 

Επειδή το σύστηµα συντεταγµένων του νέου µας αρχείου ήταν σε µοίρες δηλαδή σε σύστηµα 

συντεταγµένων WGS 84, επιλέγουµε την εντολή «Save As» σε νέο φάκελο αλλάζοντας απλά 

το σύστηµα συντεταγµένων σε ΕΓΣΑ 87 (Greek Grid – 2100). Το όνοµα που 

χρησιµοποιήσαµε αυτή την φορά ήταν το «ipsometro_arxiko». 

 

Στην συνέχεια έπρεπε να περιορίσουµε το layer µε τις ισοϋψείς στα όρια του Νοµού Ηλείας. 

Από την γραµµή εργαλείων επιλέξαµε διαδοχικά τις εντολές Vector => Geoprocessing Tools 

=> Clip. Ως input layer βάλαµε το ipsometro_arxiko και ως clip layer το νοµό Ηλείας. Τέλος 

το αποθηκεύσαµε σε καινούργιο φάκελο µε όνοµα ipsometro_ilias. 
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Εικόνα 46: Ο χάρτης µετά την λειτουργία περικοπής των ισοϋψών καµπύλων µε βάση το 
Νοµό Ηλείας. Κάθε καµπύλη αντιπροσωπεύει µια τιµή υψοµέτρου. 

 

Στο συγκεκριµένο αρχείο οι ισοϋψείς καµπύλες µας παρέχουν πληροφορίες για το υψόµετρο 

ανά 25 µέτρα. Για να εµφανίσουµε στο χάρτη το υψόµετρο που αντιπροσωπεύει κάθε 

καµπύλη, πατάµε δεξί κλικ στο αρχείο και επιλέγουµε Properties =>Labels και εκεί 

διαλέγαµε την εντολή «Show labels for this layer» καθώς και το «Label with Elevation».  

 

Εικόνα 47: Η εικόνα που είχαµε όταν εστιάσαµε στις ισοϋψείς καµπύλες του χάρτη έχοντας 
ενεργοποιηµένη την επιλογή «Show labels for this layer».Βλέπουµε το υψόµετρο 

παρουσιάζεται ανά 25 µέτρα 
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5.3 ∆ηµιουργία ψηφιακού υψοµετρικού µοντέλου µε επιφανειακή 

ολοκλήρωση  

 

Για να δηµιουργήσουµε το ψηφιακό υψοµετρικό µοντέλο (DEM) ακολουθήσαµε την 

διαδικασία της επιφανειακής ολοκλήρωσης (Spatial Interpolation) µέσω της οποίας 

δηµιουργήσαµε τιµές υψοµέτρου και µεταξύ των ισοϋψών καµπύλων. Από την γραµµή 

εργαλείων επιλέξαµε τις εντολές Raster => Analysis => Grid (interopolation) και στο 

παράθυρο που µας άνοιξε επιλέξαµε ως input file το «ipsometro_ilias», και ως Z Field το 

«Elevation». Tέλος επιλέξαµε τοποθεσία και όνοµα αποθήκευσης και πατήσαµε ΟΚ. 

 

 

Εικόνα 48: Η εικόνα του χάρτη µας µετά την επιφανειακή ολοκλήρωση. Τα διανυσµατικά 
δεδοµένα µας µετατράπηκαν σε ψηφιδωτά. Κάθε pixel στο πλέγµα εδάφους αντιπροσωπεύει 
το µέσο υψόµετρο σε µέτρα σε αυτή την τοποθεσία. Τα σκούρα pixels αντιπροσωπεύουν 
περιοχές µε χαµηλό υψόµετρο και τα ανοιχτόχρωµα pixels αντιπροσωπεύουν περιοχές µε 

µεγάλο υψόµετρο. 
 

Επόµενο βήµα ήταν να αποκόψουµε το Νοµό Ηλείας δηλαδή να µην εµφανίζονταν τιµές και 

χρώµατα πάνω στην θάλασσα ή σε γειτονικούς νοµούς. Για να το κάνουµε αυτό ξαναπήγαµε 

στην γραµµή εργαλείων και επιλέξαµε τις εντολές Raster => Extraction => Clipper. Στο 

αναδυόµενο παράθυρο (Εικόνα 50) επιλέξαµε, ως input file to raster που είχαµε και ως Out 
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file ,το νέο σηµείο αποθήκευσης µε το όνοµα: Raster_Clipper_ilias. Στην συνέχεια 

ενεργοποιήσαµε το no data value και το αφήσαµε µηδέν ώστε το σύστηµα να λάβει υπόψη 

στην επεξεργασία και τις περιοχές µε µηδενικό υψόµετρο. Στο Clipping Mode επιλέξαµε ως 

µάσκα το νοµό Ηλείας, τα υπόλοιπα πεδία τα αφήσαµε ως είχαν και τελειώσαµε την 

επεξεργασία πατώντας ΟΚ. 

 

Εικόνα 49: Το µενού της λειτουργίας Clipper µέσω του οποίου περιορίσαµε την έκταση του 
Raster µέσα στα όρια του πολυγώνου του Νοµού Ηλείας 

 

Έπειτα από την γραµµή εργαλείων επιλέξαµε Raster, Terain Analysis και Slope . Εισάγαµε το 

raster µε τα υψόµετρα που είχαµε κόψει για το νοµό Ηλείας και το σώσαµε σε νέο φάκελο µε 

όνοµα «raster_ilia_slope». Στο Z factor σηµειώσαµε  τον αριθµό ένα και πατήσαµε OK. 

 

 

Εικόνα 50: Το µενού Slope µέσω του οποίου δηµιουργήσαµε τις κλίσεις εδάφους. Ο αριθµός 
Ζ µας δείχνει την αναλογία διαστάσεων δηλαδή την σχέση που συνδέει τη µονάδα µέτρησης 

µήκους µε την αντίστοιχη του ύψους. 

Το αποτέλεσµα που προέκυψε φαίνεται στην Εικόνα 52. 
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Εικόνα 51: Ο χάρτης µας, µε τις κλίσεις εδάφους του νοµού Ηλείας. Με µαύρο χρώµα 
φαίνονται οι περιοχές στις οποίες εµφανίζεται µικρή αλλαγή στο υψόµετρο και µε άσπρο 
χρώµα οι περιοχές στις οποίες εµφανίζεται απότοµη αλλαγή στο υψόµετρο δηλαδή οι 

περιοχές που η µορφολογία του εδάφους παρουσιάζει µεγάλη κλίση.   

 

5.4 Κατηγοριοποίηση της κλίσης του εδάφους 

 

Η κατηγοριοποίηση της κλίσης του εδάφους έγινε σύµφωνα µε την ΚΥΑ 168040/2010 (ΦΕΚ 

1528 Β’), δηλαδή: 

• Πρώτη κατηγορία κλίσης: 0% έως 8%,  

• ∆εύτερη κατηγορία κλίσης: 8% έως 25%  

• Τρίτη κατηγορία κλίσης: πάνω από 25%.  

 

Για να το κάνουµε πήγαµε στο Properties και από το µενού Style (Εικόνα 53) επιλέξαµε ως 

Render type, το SingleBand pseudocolor. Στο πεδίο Interpolation διαλέξαµε την εντολή 

Discrete που σηµαίνει διακριτές τιµές και στο πεδίο Mode την εντολή Equal interval. Κάτω 

δεξιά στο πίνακα ορίσαµε τις τρεις κλάσεις - κατηγορίες κλίσεων. Στο Value του παραθύρου 

αλλάξαµε την πρώτη τιµή σε 8, την δεύτερη σε 25 και την Τρίτη σε 99. Η κάθε µία θα 

αντιστοιχούσε στις περιοχές που είχαν ύψος κλίσης από 0 έως 8 ,από 8 έως 25 και από 25 έως 

100 αντίστοιχα. 
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Εικόνα 52: Από το µενού Style, του raster που περιέχει τις κλίσεις, κάναµε την µορφοποίηση 
των ψηφιδωτών δεδοµένων και χωρίσαµε το ύψος κλίσης για τα εδάφη του Νοµού Ηλείας σε 

τρεις κατηγορίες.  

 

Με βάση τα κριτήρια αυτά µπορούµε να κατατάξουµε τα εδάφη του Νοµού Ηλείας µε βάση 

το κριτήριο της κλίσης, σε περιοχές µε κλίση από 0 έως 8 οι οποίες αποτελούν γη υψηλής 

παραγωγικότητας, ως Κατηγορία 1, και στις οποίες π.χ. ενδείκνυται η καλλιέργεια υπαίθριων 

λαχανικών τις περιοχές µε κλίση από 8 έως 25 ως Κατηγορία 2, ενώ τις περιοχές µε κλίση 

πάνω από 25% ως Κατηγορία 3.  

Για να το κάνουµε αυτό, από την γραµµή εργαλείων επιλέξαµε διαδοχικά τις εντολές View 

=> Panels => Toolbox και εµφανίζεται ένα νέο παράθυρο που περιέχει τα διάφορα εργαλεία 

του QGIS. Επιλέξαµε το εργαλείο «r.reclass» και στο παράθυρο που αναδύθηκε επιλέξαµε ως 

input raster Layer το raster µε τις κλίσεις. Στην συνέχεια δηµιουργήσαµε στην επιφάνεια 

εργασίας του υπολογιστή ένα αρχείο µορφής (.txt) στο οποίο καταχωρήσαµε τις κλάσεις 

όπως απεικονίζεται στην Εικόνα 54 και το εισάγαµε στο πεδίο παραθύρου µε την εντολή 
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«File containing reclass rules». Τέλος επιλέξαµε τοποθεσία και όνοµα αποθήκευσης του νέου 

raster αρχείου και πατήσαµε Run. 

 

Εικόνα 53: Το κείµενο που γράψαµε στο wordPad της µορφής .txt 

 

Στην συνέχεια µε δεξί κλικ πάνω στο αρχείο µε τις κλίσεις εδάφους επιλέξαµε properties και 

από την µπάρα του Style ορίσαµε ως στυλ µορφοποίησης: pseudocolor , ως interpolation το 

exact και ως mode το Quantile. Επιπλέον επιλέξαµε τρια χρώµατα για τις τρεις κατηγορίες 

και τις ονοµάσαµε στο value διαδοχικά «1, 2, 3». Το τελικό αποτέλεσµα φαίνεται στην 

Εικόνα 55. 

 

Εικόνα 54: Ο χάρτης του Νοµού Ηλείας χωρισµένος σε τρεις κατηγορίες µε βάση την κλίση 
του εδάφους. Οι µπλε περιοχές απεικονίζουν αυτές που η κλίση είναι µικρή δηλαδή από 0 
έως 8 %, οι κόκκινες περιοχές, έχουν µέτρια κλίση δηλαδή από 8 έως 25% και µε κίτρινο 

χρώµα, αυτές που έχουν µεγάλη κλίση δηλαδή πάνω από 25%. 



 

62 

 

6 ΤΕΤΑΡΤΗ ΕΦΑΡΜΟΓΗ 
 

6.1 Εισαγωγή 

Στην τέταρτη εφαρµογή περιγράφεται η διαδικασία γεωαναφοράς ενός αναλογικού χάρτη στο 

σύστηµα συντεταγµένων ΕΓΣΑ 87. 

Η γεωαναφορά (Georeference) αναφέρεται στη διαδικασία κατά την οποία προσδίδονται 

συντεταγµένες επιθυµητού συστήµατος αναφοράς συντεταγµένων σε µία ψηφιακή εικόνα 

που έχει προέλθει από σάρωση ενός τοπογραφικού χάρτη ή µιας αεροφωτογραφίας σε 

συσκευή σαρωτή (scanner). Η εικόνα που προκύπτει ονοµάζεται έτσι γεωαναφερόµενη και 

µπορεί να χρησιµοποιηθεί για την εξαγωγή χαρτογραφικών πληροφοριών σε διανυσµατική 

µορφή µε την διαδικασία της ψηφιοποίησης σε περιβάλλον Συστηµάτων Γεωγραφικών 

Πληροφοριών ή να συνδυαστεί µε ήδη υπάρχοντα ψηφιακά χωρικά δεδοµένα για την 

δηµιουργία χαρτοσύνθεσης ή την χωρική ανάλυση και εξαγωγή συµπερασµάτων, µε την 

προϋπόθεση την ύπαρξη ενός κοινού συστήµατος γεωγραφικής αναφοράς. 

6.2 Γεωαναφορά αναλογικού χάρτη 
 

Με υπόβαθρο το shapefile των νοµών της Ελλάδος ξεκινήσαµε την διαδικασία της 

γεωαναφοράς ακολουθώντας από την γραµµή εργαλείων τα εξής βήµατα: Raster => 

Georeferencer => Georeferencer. 

 

Εικόνα 55: Η εντολή Georeferencer  στην γραµµή εργαλείων  
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Στη συνέχεια επιλέξαµε την εικόνα του χάρτη της Πελοποννήσου την οποία θα 

γεωαναφέρουµε µε την επιλογή File και την εντολή Open Raster. Η εικόνα προέκυψε από 

χάρτη τον οποίο είχαµε σαρώσει και είχαµε περάσει µέσα στον υπολογιστή µας. Στην 

συνέχεια επιλέξαµε το επιθυµητό σύστηµα αναφοράς αυτής της εικόνας. Εµείς επιλέξαµε το 

Ελληνικό προβολικό σύστηµα  ΕΓΣΑ 87 (GreekGrid - EPSG:2100). 

Η εικόνα του χάρτη εµφανίστηκε στο παράθυρο του Georeferencer και µε το ποντίκι 

µπορούµε να επιλέξουµε ένα σηµείο επάνω στην εικόνα το οποίο θα το ταιριάζαµε επάνω στο 

αντίστοιχο σηµείο του υποβάθρου δηλαδή του shapefile των νοµών. Μόλις επιλέξαµε ένα 

σηµείο στην εικόνα µας, εµφανίστηκε το παρακάτω παράθυρο στο οποίο επιλέξαµε την 

επιλογή From map canvas. 

 

Εικόνα 56: Το παράθυρο που µας εµφανίστηκε πατώντας πάνω στην εικόνα. Επιλέγοντας 
την εντολή «From map canvas» µας δίνεται η δυνατότητα να επιλέξουµε το σηµείο του χάρτη 
που ήδη έχουµε στο καµβά µας το οποίο αντιστοιχεί στις ίδιες συντεταγµένες µε το σηµείο 

που επιλέξαµε στην εικόνα. 

 

Κατά την διαδικασία αυτή έπρεπε να προσέξουµε ιδιατέρως ώστε τα σηµεία που θα 

επιλέξουµε για αντιστοιχία, µεταξύ καµβά και γεωαναφερόµενης εικόνας, να είναι όσο το 

δυνατόν πιο ακριβή µπορούµε. Συνεχίσαµε την ίδια διαδικασία για έξι σηµεία τα οποία 

θεωρούνται ικανοποιητικός αριθµός για γεωαναφορά περιοχής αυτού του µεγέθους και για 

τους σκοπούς αυτής της εργασίας. Βέβαια όσο πιο πολλά σηµεία είχαµε τοσο µεγαλύτερη 

ακριβεια θα είχε η γεωαναφορά.  
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Εικόνα 57: Κατά την διαδικασία της αντιστοιχίας σηµείων η εφαρµογή που αναφέρει στο 
GCP Table τον αριθµό των σηµείων µαζί µε τις συντεταγµένες τους. 

 

Στη συνέχεια επιλέξαµε από την γραµµή εντολών του Georeferencer την εντολή File και στην 

συνέχεια την εντολή Start Georeferencing. Στο παράθυρο το οποίο άνοιξε ορίσαµε ως τύπο 

µετασχηµετισµού επιλέξαµε Helmert ενώ στην µέθοδο επαναδειγµατοληψίας επιλέξαµε το 

Nearest Neighbour. Τέλος επιλέξαµε σηµείο αποθήκευσης και ονοµασία αρχείου (Εικόνα 58). 

Τέλος επιλέξαµε από την γραµµή εντολών τις εντολές: File => Start Georeferencing. Η 

διαδικασία ολοκληρώθηκε επιλέγοντας ως σύστηµα συντεταγµένων το ΕΓΣΑ 87 (Greek Grid 

- EPSG:2100) και πλέον στο καµβά µας υπήρχε ο γεωαναφερµένος χάρτης της 

Πελοποννήσου (Εικόνα 59). 
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Εικόνα 58: Το µενού του Transformation Settings το οποία µας ζητούσε να καθορίσουµε 
κάποιες παραµέτρους βάση µε τους οποίους θα γινόταν η γεωαναφορά. 

 

Με αυτό το τρόπο µπορούµε να ψηφιοποιήσουµε σε κάθε σηµείο της Πελοποννήσου τις 

πληροφορίες που περιείχε ο χάρτης που εισάγαµε. 

 

Εικόνα 59: Η τελική εικόνα που προέκυψε στο καµβά µετά την διαδικασία της γεωναφοράς. 
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7 ΣΥΜΠΕΡΑΣΜΑΤΑ 
 

Η χρήση λογισµικών GIS είναι απαραίτητο συστατικό στο τοµέα της διαχείρισης χωρικών 

πληροφοριών και της χαρτογράφησης στη αγροτική παραγωγή. Η χρήση των GIS λογισµικών 

έγκειται στην µετατροπή των αναλογικών πληροφοριών και δεδοµένων σε ψηφιακή µορφή 

και στην συνέχεια στην επεικόνισή τους σε µορφή ψηφιακών χαρτών. Αυτό επιτυγχάνεται µε 

εποπτικό τρόπο, που κάνει όλη την διαδικασία ελκυστική στους χρήστες. Οι δυνατοτητες που 

παρέχονται είναι πολύ σηµαντικές αφού µέσω αυτών µπορεί να λύθούν σύνθετα χωρικά 

προβλήµατα χρησιµοποιώντας πολλαπλά επίπεδα δεδοµένων για την επιλυσή τους.  

Ο σκοπός της παρούσας πτυχιακής εργασίας είναι να φανούν οι δυνατότητες των GIS µέσω 

εφαρµογών σε διαφορετικές χωρικές κλίµακες, από επίπεδο αγροτεµαχίου µέχρι ολόκληρο το 

Νοµό Ηλείας. Επίσης, έγινε προσπάθεια να παρουσιαστούν εφαρµογές που αφορούν 

καλλιεργούµενα αγροτεµάχια και τις ιδιότητες τους, όπως η εδαφική υγρασία και η κλίση του 

εδάφους, µε σκοπό να αναδειχθεί η χρησιµότητα του λογισµικού GIS ως καθοριστικό 

εργαλείο στη γεωπονική επιστήµη. Οι γεωπόνοι µπορούν να εισάγουν τα αγροτεµάχια των 

αγροτών και να προσθέτουν layers µε χωρικές πληροφορίες στο αντίστοιχο χάρτη. Επίσης 

µπορούν να διαχείριζονται πληροφορίες από διάφορους αισθητήρες ή να συλλέγουν 

πληροφορίες τηλεπισκόπισης και να τις συνθέτουν σε ψηφιακούς χάρτες.  

Συµπερασµατικά µπορούµε να πούµε ότι η εφαρµογή QGIS αποτελεί ικανή εναλλακτική 

λύση απέναντι στις αντίστοιχες εµπορικές εφαρµογές, µιας και το περιβάλλον χρήσης πλέον 

είναι εύχρηστο. Σηµαντικό ρόλο παίζει η υφιστάµενη διαδικτυακή κοινότητα των χρηστών 

του, διότι οποιοδήποτε πρόβληµα µπορεί να απαντηθεί άµεσα στα αντίστοιχα forum του 

διαδικτύου. Tα συστήµατα γεωγραφικών πληροφοριών αποτελούν το µέλλον της γεωργίας 

και είναι στα χέρια µας να τα αξιοποιήσουµε στο µέγιστο βαθµό. 
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